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Abstract

The Pinalefio Mountains, an isolated sky island in southeastern Arizona, contains the southernmost expanse of a spruce/fir forest type
in North America as well as one of the most extensive mixed-conifer forests this far south. The high-elevation ecosystems support the
only habitat for the Mount Graham red squirrel (Tamiasciurus hudsonicus grahamenis) (MGRS), a federally listed endangered species.
Changes in forest composition and structure, along with several recent large and severe wildfires and devastating insect outbreaks, have
greatly altered the habitat for the MGRS. The risk of additional wildfires and insect outbreaks has led the forest to begin a restoration
effort, attempting to balance fuel reduction with habitat conservation. As part of this restoration effort, the Coronado National Forest
is pursuing airborne lidar technology as a potentially cost-effective way to provide current and detailed information on forest
structure. The derived information will be used to plan, implement, and monitor ecosystem restoration and assist in creating a MGRS
habitat model.

Airborne lidar data were collected in late September 2008 over 85,518 acres, covering the forested portion of the Pinaleio Mountains.
Once the lidar data were delivered to the U.S. Department of Agriculture Forest Service (USES) in February 2009, a quality
assessment was done to ensure that data met the criteria for optimal forest mapping based on the technical specification completed in
April 2008 as a part of this project (Laes and others 2008). This quality assessment used an assemblage of software, including the
Fusion catalog function developed by the USFS, ArcGIS, and finally the U.S. Geological Survey (USGS) consistency software
program. This report describes this process.

Once the lidar data passed the technical-specification qualification, numerous base raster GIS layers containing forest-canopy,
structure, and fuel-related information extracted from the lidar point cloud were developed. These lidar-derived raster data layers
included a number of models depicting the forest floor and fuel beds, canopy surface and height, canopy volume and outer surface
area, and bare earth. Field data collected during the summer of 2009 will help establish statistical relationships between the conditions
on the ground and the lidar raster GIS data. These relationships will be used to model forest structure and improve the understanding
of current forest conditions within the Pinalefio Mountains. The appendices in this report details the steps and scripts to facilitate
lidar data processing and contain a complete list of output files, descriptions of the data-processing flow, and visuals of the lidar-
derived models. The final phase of the project—establishing the statistical relationships between the field and lidar-derived layers—
will be completed in 2010.
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Background

Conducting forest inventory in remote,
steep, and rugged areas can be cost
prohibitive and may compromise
field-crew safety. The Coronado
National Forest acquired airborne lidar
data to investigate its ability to derive
forest-structure, fuel, and biomass
information in a safer, more-practical,
and cost-effective way. The derived
forest information will be used to
implement and monitor ecosystem
restoration, develop forest-health
monitoring tools such as Douglas-fir
beetle-risk factors, assist in creating a
Mount Graham red squirrel
(Tamiasciurus hudsonicus grabamenis)
(MGRS) habitat model and monitor
treatments; and piece together likely
presettlement forest characteristics,
based on such data as historical aspen
clones, remaining patches of old
growth, and other forest demographics.

Phase one of this project compiled the
technical specifications for lidar data
acquisition (Laes and others 2008);
secured the necessary funds from the
U.S. Department of Agriculture
southwestern regional office, the
Coronado National Forest (USFES),
forest health monitoring-interior west
office, and the USFS Remote Sensing
Steering Committee; and evaluated the
submitted responses to the request for
quotations (RFQ). The RFQ was
posted in early July of 2008, and the
contract was awarded in August. The
data collection was complete by the end
of September and delivered to the
Forest Service in February of 2009.

Objectives

This report documents the second phase
of the Pinalefio Mountains lidar project.
The objectives of phase two were the
following:

1. Assure that the lidar data delivered
by the vendor complied with the
contract specifications;

2. Develop and document a quality
assessment for lidar data coming
from a vendor; and

Figure 1—A view toward the southwest from the Pinaleifio Mountains.

3. Develop the raster GIS layers
containing forest-canopy, structure,
and fuel related information
extracted from the lidar point cloud.

The next project phase will use field
data collected during the summer of
2009 to establish statistical relationships
between the conditions on the ground
and the lidar data. These relationships
will aid in modeling forest structure
based on some of the derived raster
layers (grids). Other raster layers can be
employed immediately to improve the
understanding of current forest
conditions within the Pinalefio
Mountains (figure 1).

This report describes the lidar data, the
quality assessment performed after data
delivery, and the initial data-processing
steps. During this time, information
was extracted from the lidar point cloud

and transformed into raster layers (in
ESRI grid format). Each of these grids
contains a specific data derivative or
parameter that can form the basis for
future modeling. To make this report as
concise as possible, familiarity with lidar
terminology is assumed. A lidar tutorial
is available at the following site: htep://
www.fs.fed.us/eng/rsac/lidar/

Appendices to the report contain all the
steps and the DOS batch scripts used in
the lidar data processing, a list of output
file names, a brief description of the
data-processing flow, and a data
dictionary with visuals of various grids
created for the entire project area. The
scripting supplement may be useful for
those trying to process lidar data in an
automated way while the data
dictionary will help during future
modeling.
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Figure 2—O0n the left, the location of the project area in the Pinalefio Mountains; on the right, the project area within the bounderies of

the Coronado National Forest.

Project Study Area

The project study area covers
approximately 85,500 acres (34,600
hectares) in the mixed-conifer zone
above 7,000 feet (2,133 meters) within
the Pinalefio Mountains, located
southwest of Safford, Arizona (figure 2).
The Pinalefio range is an isolated
Madrean sky island and contains the
southernmost expanse of a spruce/fir
forest in North America as well as one
of the most extensive mixed-conifer
forests this far south. The high-elevation
ecosystems have been isolated for the
last 11,000 years and support the only
habitat for the Mount Graham red
squirrel (figure 3), a federally listed
endangered species. The range has
experienced similar post—Euro-
American settlement changes in forest
composition and structure to other
southwestern mixed-conifer forests. The
presettlement and pre—fire-suppression
forests were more open with less
forest-floor fuel, favoring more-
frequent, but less-intense, fires

(Covington and Moore 1994). Recent
changes have led to several large and
uncharacteristically severe wildfires and
a series of devastating insect outbreaks.
Particularly hard hit have been the
spruce and fir trees, with mortality
estimates of more than 80 percent. This
was the primary habitat for the MGRS.
The remaining habitat is now reduced
primarily to the transitional zone
between the spruce/fir and mixed-
conifer forest, sometimes referred to as
wet mixed-conifer forest (Wood and
others 2007).

Lidar Data

Definition of Lidar

Lidar is an acronym for light detection
and ranging. Lidar systems measure
distances using the same principle as a
laser rangefinder. The travel time of
each laser pulse to an object and back is
divided by two and multiplied by the
speed of light (299,792,458 meters per

second) to calculate the precise distance,

Figure 3—Mount Graham red squirrel (T.
hudsonicus grahamensis) in its natural
habitat.

and the accuracy is dependent on the
timing device. An airborne topographic
lidar system scans, receives, and
georeferences multiple pulse returns
(echoes) from the ground, treetops,
rooftop, and other objects tens of
thousands of times per second. The
system uses an IMU (inertial
measurement unit) and a GPS (global
positioning system) to record the
geolocation of each lidar return in three
dimensions (Wehr and Lohr 1999;
Baltsavias 1999).

2 | RSAC-0118-RPT 1



Acquisition Specifications and
Timeline

After an evaluation of the responses to a
competitive bidding process, the
contract for the discrete-return lidar-
data acquisition over the Pinalefio
Mountains was awarded in mid-August
of 2008 for $105,013. The vendor,
Watershed Sciences, completed the
leaf-on data collection between
September 22 and September 27, 2008,
according to the mission specification in
table 1, covering an area of 85,518 acres

(figure 4).

Description of Deliverables

A portable hard drive with 91 gigabytes
of data arrived at the Remote Sensing
Applications Center (RSAC) during the
first week of February 2009, nearly two
months later than the date in the
contract agreement. The disk contained
all the requested data files. The lidar
point data were organized in 236 tiles in
the common binary lidar-exchange

Table 1—Pinaleiio Mountains lidar-acquisition specifications

Acquisition dates

September 22-27, 2008; Leaf-on

Aircraft

Cessna Caravan

Lidar scanner

Leica ALS50 Phase 2

Pulse rate 70 to 90 kHz
Scan rate 52.2 Hz
Maximum returns per pulse 4

Scan angle +/-15 degrees
Beam divergence 19-29 cm
Flight above ground level 800-1300 m
Flight line configuration Opposing adjacent parallel lines
Flight line overlap 50% sidelap
Avergge lidar pulse-return 7.36 points/m?
spacing

Average ground-point density 0.98 points/m?
Acquisition area 85,518 acres
Total numbers of returns 2,892,925,979

The projection information for the spatial data is UTM zone 12 NAD83 and
NADV88 geoid03. Both horizontal and vertical units are in meters.

Figure 4—The Cessna Caravan and Leica ALS50 Phase 2 instrument that were used in lidar acquisition.
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format or LAS. One LAS point tile
corresponds to a 1/25th section of a
3.75-minute digital orthophoto quarter
quadrangle (DOQQ). The bare-earth
models were in ESRI grid format with a
1-meter spatial resolution. Because of
the resolution and the size of the project
area, the bare-earth model (as well as all
other files at 1-meter spatial resolution)
was divided into three sections split
along north/south DOQQ lines
corresponding with U.S. Geological
Survey (USGS) 1, 8, and 7 7.5-minute
quadrangle boundaries (figure 5).

Other deliverables included points
classified as “ground,” provided as
separate ASCII files; a report describing
the GPS geolocational procedures,
including information related to the
RTK (real-time kinematic) ground-
control point collection; and shape files
depicting the tile boundaries and the
flight-line trajectories.

Lidar Processing

Figure 6 shows a flowchart where the
major processing steps are grouped by

color. All but one of the analysis
procedures, described later in this
report, start from yellow boxes, which
represent the data deliverables. The field
plot data, collected during the summer
of 2009, were not provided by
watershed sciences. The volume and
outer-surface-area calculations were
based on a canopy-height model, not a
deliverable. The grey boxes with red text
list the script that was used during
processing. These batch files are detailed
in appendix 1. Green boxes represent
output grids.

Doa __[Doaa

1 3211061 | G13&G14
32110F1 | F11 & F12

B 32109G8 | GB3 & G4
32109F8 | F81, F82, F83 & F84

18 32109E8 | EB2

i 32109G7 | G73
32109F7 | F71,F72,F73 & F74
32109E7 | ET1&ET2

Figure 5—The three sections of the ArcGIS grids that Watershed Sciences delivered for the project area.
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Figure 6—A Lidar-processing flowchart developed for the project.



Quality Assessment of the
Deliverables L.

First, the delivery of all the requested

files and documentation was verified.

The data were then checked for

compliance with the technical

specifications of the contract and 2.
quality control with an assemblage of
software:

Table 2—Lidar data quality assurance checklist

The Fusion catalog function; Fusion
is a software package developed by
Bob McGaughey of the Forest
Service, Pacific Northwest Research
Station, in Seattle specifically to
analyze lidar data;

Visual inspection of the bare-earth
model, the highest-hit model, and
the flight-line trajectories with
ArcGIS; and

3. Output from the USGS consistency
software code: a combination of
unpublished ARC workstation
AMLs (arc macro language) and
Python scripts developed by Ralph
Haugerud of the USGS in Seattle.

Table 2 shows which software was used
to check different specifications in the
lidar-acquisition contract.

All requested files delivered?

Windows Explorer

File formats

Windows Explorer

Coverage of the area

Fusion catalog function

Pulse density (first-return density)

Fusion catalog function
USGS consistency function

Half minimum-pulse-density area at 30

m | Fusion catalog function

Scan angle

Export random selected LAS files to MS-Access database (from
Fusion) and run summary queries on scan-angle field. Fusion can
color the data points with the value of the scan angles. The LDV
histogram will show the maximum angle.

Data acquisition gaps

Fusion catalog function and visual inspection of the delivered
grids USGS consistency function.

Opposing adjacent flight lines

ArcGIS shape file: the difference between the from-Xand to-X
coordinate fields was used to visualize the general direction.

Absolute accuracy

Vendor RTK surveying

Bare-earth grid interpolation

Visual inspection in ArcGIS of bare-earth grid for smoothness and
indications of areas with few points (DEM looks facetted).
Comparison of bare-earth surface to highest-hit surface.

Bare-earth building and vegetation
removal

the Fusion LDA format first.

Comparison of bare-earth DTM to ground points in PDQ viewer.
The text files with the XYZ ground points need to be converted to

Point cloud outlier removal

Fusion catalog function
Fusion PDQ viewer

Relative accuracy

USGS Consistency by comparing elevation results in flat areas of
the bare-earth model from overlapping adjacent flight lines.

50% sidelap (or 100% overlap)

USGS consistency function

Accuracy error as function of increasing

slope

USGS consistency function

6 | RSAC-0118-RPT 1



The Fusion Catalog Function
The function produces an HTML file
containing the following:

B A summary table of the lidar data
listed by tile: elevation range in each
tile, XY coordinates of each tile, total
return count, return count by return
number, and return density;

B The nominal coverage based on the
geographic extent of the data tiles;

B OQutlier analysis based on a user-
defined range (mean elevation + (7)
std. dev.);

B The first-return density image,
which is an approximation of the

All of the catalog output images include
a world file and can be visualized in
ArcGIS. The output file sizes in either a
BMP and/or JPEG format depend on

the user-defined cell size.

Figure 7 shows the results of the
first-return density images with a
30-meter cell size. This size was used to
verify the specification that no 30-by-
30-meter cell should produce less than
1.5 pulses per square meter. The red
cells in the southeastern section of the
left part of figure 7, indicating that the
first return density is less than half the
contractual pulse density, coincide with

Visual Inspection of the Delivered
Surface Models

Unlike the software-based catalog and
consistency assessments, the results of
the visual inspection are not readily
quantifiable. The three sections of both
the 1-meter bare-earth and highest-hit
surfaces were merged into
corresponding 2-meter grids covering
the entire study area. Hill-shades of
these two grids were combined with a
derived height model—obtained by
subtracting the bare-earth model from
the highest-hit one—and a 4-band
National Agriculture Imagery Program

requested pulse density based on a dropped flight line. (NAIP) mosaic to evaluate the data

user-specified cell size and color visually. Investigators systematically

coding; and panned through the data at a constant
B A first-return intensity image (with

or without tile boundaries).
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[firstdensity:900,1.5,8

[firstdensity:900,3,8

pulse density: 0.43%

Percent area with data coverage below minimum

Percent area with data coverage below minimum
pulse density: 5.95%

minimum pulse density: 99.57%

Percent area with data coverage at or above

Percent area with data coverage at or above
minimum pulse density: 94.057%

Figure 7—A composite image of the Fusion catalog pulse density comparison. Red indicates cells with less than the specified pulse
density. The function was run at two resolutions: 1.5 pulses per square meter, shown on the left, and 3 pulses per square meter

depicted on the right.
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scale of 1:3,000 looking for visible
triangular facetted areas (indicative of
few ground points), outliers, data gaps,
and remnants of vegetation and

buildings.

Outliers in the delivered models
occurred mainly along steep, near-
vertical cliff edges. They were most
likely due to the algorithm used to filter
out nonground returns. A few areas in
the images may potentially still contain
vegetation or building remnants, but
neither of these should have a major
impact on future analysis.

Output from the USGS Consistency
Code

This analysis generates estimates of the
internal reproducibility of the lidar
survey. Consistency duplicates some of
the Fusion catalog analyses but adds
others, such as checking for flight-line
overlap, relative vertical and horizontal
accuracy between flight lines, ratio of
first returns to ground returns, and
changing accuracy information with
increasing slope.

Of the 18 AMLs and 25 Python scripts
making up this code, three AMLs
needed modification to reflect the

acquisition specification of the data and
the local computer environment (drive
and folder settings). Because of the large
amount of data and the processing time
required by this analysis, not every tile
needed to be analyzed. One of the
AMLs allows the user to specify a
tile-skipping factor. To speed up the
analysis even more and resolve
computer memory issues, the data tiles
were divided into seven folders (figure
8). The analyses for the seven folders
were run simultaneously. The details
and explanation of the code appear in
the documentation for the consistency
program (Haugerud, unpublished
report).
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Figure 8—A geographic representation of the grouping of the data tiles into seven separate folders used for consistency analysis.
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The program involves a two-step
process that first analyzes the selected
tiles and then produces a report in
HTML format for the larger area (in
this case, areas corresponding to the
subset of the project area in each of the
seven folders). The analysis is the more
time-consuming step. It took nearly five
days of continuous computer time to
analyze about 50 percent of the tiles.
The analysis generates a maplike graph
that visualizes the pulse density (for
ground returns, first returns, and their
ratio) and flight line overlap of each tile
in an HTML file. The relative
accuracies are determined by comparing
Z values to XY values from ground
returns in flat areas. Returns from these
areas in adjacent overlapping flight
lines, flagged by analyzing slope and
curvature, were separated by flight line
and compared. The results were
summarized at the folder level in the
HTML file, one for each folder, and
contain links to the HTML files created
for each of the tiles.

Organizing the lidar tiles allows them to
be analyzed more quickly, but
unfortunately it does not produce a

comprehensive relative accuracy for the
entire project area. The quality control
performed by Watershed Sciences, using
1,654 RTK ground-control points
measured during the time of data
acquisition, lists the absolute vertical
accuracy at 6.9 centimeters (at 20)
(Watershed Sciences 2009). The
absolute horizontal accuracy depends on
the resolution of the GPS base stations
and is designed to be within 15
centimeters at 1G. Because no easily
recognizable and measurable features in
open terrain exist on the hard surfaces
selected for the RTK survey points, the
horizontal accuracy is difficult to
analyze and is not routinely part of
Watershed Sciences’s quality control.

Relative accuracy results, indicating
flight line to flight line accuracy, are an
output of the consistency analysis, listed
in table 3. The vertical accuracy,
reflected by the P1 values, reveals that
the contractual absolute parameters (2
15 centimeters vertical on horizontal
surfaces) were met. The P2 values
reported from the consistency analysis
are the only indication of horizontal
accuracy, and they are above the

Table 3—Summary of relative accuracy for each of the seven folders

15-centimeter contract specifications.
The terrain in the project area has few
hard, flat surfaces and even fewer ones
with easily recognizable features in open
terrain that can be readily identified in
overlapping flight lines from which XV
values of the returns can be compared.
This makes it extremely difficult to
characterize the returns from two
different flight passes as really
representing the same location so
quality assessment became even more
problematic. A well-defined survey
design and verifying the base-station
instrumentation produce the best
quality control possible under these
conditions. Although the P2 values are
above the contract specs, it is difficult to
decide whether they represent real
horizontal-accuracy problems, or
whether they reflect an inability to
determine if the points of comparison
really coincide with the ground, or

both.

Conclusion of Quality Assessment
Four weeks of intense scrutiny of the
data, produced a few minor infractions
in the 50 percent sidelap criteria and

Summary of Estimates of global accuracy and completeness

G187 15 3.2 36.0 34,632
E7-12 13 3.8 31.0 22,912
F1-12 13 3.4 38.7 11,471
F7-12 15 4.2 35.9 34,988
F7-34 20 34 34.1 48,583
F8-12 24 4.3 30.0 29,252
F8-34 (includes | 17 3.7 32.3 28,464
E8-2)

The folders are colored to match their geographic location in figure 8.
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Table 4—Example of the completeness output for tiles within folder F8-12

F8101 1.623 0 99.998 6.421567 | 0 0 0 0.339 0.556
F8103 1.623 0 99.998 7.301508 | 0 0 0 0.337 0.516
F8105 1.623 0 99.992 5.932661 | 0 0 0 0.348 0.496
F8107 1.623 0 99.993 9.638238 | 0 0 0 0.361 0.564
F8109 1.623 0 99.997 6.735713 | 0 0 0 0.549 0.659
F8111 1.624 0 99.999 7.878493 | 0 0 0 0.366 0.655
F8113 1.624 0 99.963 7.206454 | 0 0.027 0.004 0.286 0.392
F8115 1.624 0 99.933 7.994095 | 0 0.039 0.07 1.268 0.791
F8117 1.624 0 99.998 11.0791 |0 0 0 0.457 0.832
F8119 1.624 0 99.794 19.31227 | 0 0.062 0.102 0.266 0.391
F8121 1.478 0 99.996 8.16995 |0 0.019 0.019 0.204 0.339
F8123 1.624 0 99.626 11.84933 | 0 0 0 0.445 0.715
F8125 1.624 0 99.998 9.967041 | 0 0 0 0.364 0.674
F8202 1.623 0 99.642 6.139299 | 0 0 0 0.595 0.671
F8204 1.623 0 98.845 8.642747 | 0 0 0 0.488 0.734
F8206 1.623 0 99.517 7.357137 | 0 0 0 0.722 0.806
F8208 1.623 0 99.783 8.688858 | 0 0 0 0.708 0.761
F8210 1.623 0 99.803 10.10022 | 0 0 0 0.649 0.7

F8212 1.624 0 99.958 9.897661 | 0 0 0 0.156 0.268
F8214 1.624 0 99.951 1377929 | 0 0 0 0.205 0.307
F8216 1.624 0 99.299 14.93763 | 0 0 0 0.403 0.559
F8218 1.624 0 99.998 14.95608 | 0 0.098 0.128 0.138 0.221
F8222 1.624 0 98.975 8.958092 | 0 0.021 0.039 0.615 0.712
F8224 1.624 0 98.43 8.369454 | 0 0.042 0.077 0.237 0.277

also a few 30-by-30 meter cells with less
than half the minimum specified
density of 1.5 pulses per square meter.
Most of these problems are explained by
the steep and very rugged terrain.
Turbulence resulting from warmer air
temperatures starting daily around noon
(typical for the mountainous terrain, the
locale, and the time of the year) made
flying during the afternoon more
difficult. Since these problems were not
due to poor mission planning and did
not unduly affect further analysis, no
objections were raised with the
contractor. Other lidar acquisitions

contracted by the Forest Service indicate
that the “no 30-by-30-meter results at
half the minimum pulse density”
specification may be too strict, given the
current technology mounted in a plane
and data collection over mountainous
terrain (McGaughey, personal
communication).

The contractor delivered all the required
files and documentation, most at the
contractual specifications and some
exceeding them (such as accuracy and
pulse density). The requested density of
three pulses per square meter was not

met in 5.95 percent of the area when
measured with 30-by-30-meter cells.
Most of the errors occurred along a
dropped flight line. The average pulse
density for the entire project area was
7.36 points/m2. However, this density
was uneven, obviously affecting the
analysis of some of the derived raster
parameters, particularly those that
might provide insight into surface fuels

(table 4).
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Development of Project-Area
Grids from the Lidar Point Data

All of the analysis on the point data was
done with the Fusion software
developed by the Pacific Northwest
Research Station of the USFS
(McGaughey and others 2004).
Detailed syntax explanations are located
in the Fusion manual (McGaughey
2009).

Bare-Earth Models

The bare-earth model was generated by
Watershed Sciences and delivered in
ArcGIS grid format. The grids were

converted to the Fusion Plans DTM
format before analysis could begin. A
bare-earth model represents the
topographic elevation of the area after
all the vegetation and buildings have
been removed (Kraus and Pfeifer 1998).
Haugerud (unpublished report)
mentions that, on average, about one in
three pulses will hit the surface under
forest conditions that are not too dense.
According to Watershed Sciences, the
ground-point density was on average
one pulse per square meter, allowing a
1-meter bare-earth model. The
delivered grids were converted to a
1-meter and 3-meter Fusion-ready

DTM surface. The 1-meter DTMs were
used to normalize the point cloud
during gridmetric calculations. Both the
1-meter bare-earth model and those
DTMs covering the area in three
sections were too large for Fusion’s
memory. To complete the gridmetrics
calculations, the 1-meter bare-earth
model was clipped into smaller DOQQ
sections. The bare-earth model can be
used for watershed delineations,
soil-erosion studies, and any other type
of project that requires digital elevation

models (figure 9).

Figure 9—A powerful visual comparison between the 1-meter lidar-derived bare-earth model (on the left) and a 30-meter USGS
digital elevation model (on the right). The white grid indicates the lidar tile boundaries.
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Figure 10—A three-layer offset of a canopy surface model (CSM), bare-earth model
(BE), and canopy height model (CHM) derived from data tile F8219.

Canopy Models

A canopy model is derived by creating
a surface from the highest returns
within a cell. These are usually the first
returns. This model includes the upper
surface of the trees as well as buildings if
the returns from structures are not
eliminated from the point cloud or the
structures are obscured by taller trees.
When the absolute values of the returns
are used, a canopy surface model (CSM)
is created. The CSM is an elevation
model where tree heights (as well as
other objects such as buildings) are
superimposed on the topographic
depiction. To derive heights of trees,
called the canopy height model (CHM),
a more meaningful metric from a
forestry point of view, the CSM needs
to be normalized to the topographic
elevation by subtracting the interpolated
bare-earth model (figure 10). Besides
the quality of the lidar data, a good,
reliable bare-earth model determines the

quality of the CHM.

By using the CSM, inferences about
tree height can be made for the entire
project area without time-consuming

field measurements and dealing with
difficult-to-access terrain (figure 11).
Lidar data have the tendency to
underestimate actual tree height. How
much that happens depends on the
accuracy of the data, the pulse density,
and the quality of the bare-earth model
as well as a tree species—more
specifically the shape of the top of the
tree. Based on information from the
field plots, adjustments can be made if
necessary (figure 12 and 13). The CHM
is generated at 2.5-and 3-meter spatial
resolution.

Canopy Surfaces and Volume
Models

The 2.5-meter CHM was used as input
to create canopy-volume and surface-
area layers (figure 14). All these layers
are derived at a multiple cell size of the
original CHM. Past studies have
indicated that the canopy complexity or
surface ruggedness can be correlated
with the developmental stage of the
forest (Parker and Russ 2004; Kane and
others 2008).

An overall indication of the canopy
density can be derived from the volume
models (figure 15). When all the cells
have a relatively high value for the
canopy height, the surface filled volume
(SFV) will be high. After beetle
infestations or severe fires, when the
forest is characterized by standing snags,
logs, and open canopy, the surface
potential volume (SPV) can still be high
because of the presence of a few taller
snags, but the SFV will be low because
many cells will have low canopy heights.
The canopy SFV, together with cover
and CHMs, can be used to create
disturbance models. After field data are
acquired and processed, these volume
layers may be explored for their
potential relationship to stand density.

Gridmetrics

Several research studies have shown that
statistical modeling of lidar data can be
used with forestry plot data to derive
canopy structural information at the
plot and stand level (Means and others
1999; Naesset and others 2004;
Heurich and Thoma 2008; Hudak and
others 2008). Fusion’s gridmetrics
function computes a series of descriptive
statistics for a lidar data set based on the
returns within a user-defined grid cell.
The resulting parameters are the same as
those calculated by cloudmetrics, the
function used to process returns from
the lidar point data corresponding to
the field plot locations. The gridmetrics
function converts the statistical output
to a grid. Besides statistics, each grid
contains implicit spatial information,
making it possible to derive forest
canopy data over the entire project area.
This results when the models derived
from building relationships between
plot data and their corresponding lidar
point cloud are applied to the
gridmetric-derived rasters.

Except for the cover calculations, all the
outputs from this analysis (table 5) are
height related and derive statistical
information from the point data at 2
meters above the ground and summarize
it on a 25-meter raster grid. Returns
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Figure 11—A canopy height model, the pixels with a value > 25 m are shown in red.
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Figure 12—An old-growth stand near Riggs Lake: note that only a few areas on the ground show gaps in the canopy
through which the sun illuminates the forest floor; also note the absence of a thick understory.
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Figure 13—A point cloud representation of old-growth trees in the Riggs Lake area. The overhead view on the left contains a
small inset image to locate the coincident tree stand on the ground. The same area appears obliquely in the data cloud on the

right.

Table 5—Grids created with gridmetrics

Descriptive statistical height information

skewht, kurtht, aadht

Pulsecnt, minht, maxht, aveht, modeht, stdevht, varianht, cvht,

Percentile height distribution of returns

p75ht, p80ht, p90ht, p95ht

p05ht, p10ht, p20ht, p25ht, p30ht, p40ht, p50ht, p60ht, p70ht,

Cover (figure 16)

(# of 1st returns > height break) / (total number of 1st returns)

“E (elevation relief ratio)

Derived from gridmetrics: E = (aveht - minht) / (maxht - minht)

"Parker and Russ 2004

lower than 2 meters above the ground
are eliminated from the analysis to
separate ground points—the effects of
boulders, shrubs, and logs—from
canopy returns (Naesset 2002; Naesset
2004). Canopy cover is calculated at 3
meters above the ground according to
the proportion of first returns above 3
meters in a cell (Strunk and others
2008).

The 25-meter output cell size of the
grids was chosen because it is close to
the 0.05-hectarefield plot size, which is
large enough to summarize forest
conditions, not the individual trees
(figure 16). Minimum height values
should be around the understory cutoff
of 2 meters. Higher values indicate
canopy too dense for the laser pulse to

penetrate to the understory or no
returns between 2 meters above the
ground surface and the minimum value
were measured. Either the 90th or 95th
percentile height raster is a good
indicator of canopy height.

Fuel-Bed Obstacle Density
Obstacle density is a concept that
Seielstad and Queen (2003) borrowed
from aerodynamic roughness literature
to describe nonground lidar returns in
the forest fuel bed (2 2 meters above the
ground). It is defined as the number of
nonground points within the fuel bed
per square meter, normalized by the
total number of ground and fuel
returns.

The densities of the returns are
calculated with Fusion’s densitymetrics
functions. Before the densities can be
determined, the delivered ground-point
ASCII tiles have to be converted to
Fusion’s LDA format, a binary format
similar to LAS, but without all its
required headers and placeholders. After
calculating the densitymetrics of the
ground points and the part of the data
lower than 2 meters above ground,
ArcGIS derives the understory fuel-bed
densities by subtracting the ground-
point density from the less-than-2-
meter data. Normalizing the fuel-bed
densities to all the returns in the
under-2-meter data, including the
ground points, generates the obstacle

density.
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Figure 14—O0Id-growth stand southeast of Riggs Lake: a)1-meter NAIP with CHM = 25 m in red; b) canopy cover calculation at 25 m;
¢) CHM calculated at 2.5 m; d) surface area ratio; e)forest floor visualization at 1 m; f)filled volume (surface volume ratio) at 25 m;
g) point-cloud visualization of canopy height; h) understory vegetation/litter < 2 m visualization.
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Surface volume (SV) for 3 by 3 cell

A SY = 1696 (sum of individual cells)
B.SV= 306

Surface potential volume (SPYV)

C.SPV =2232(9 *24 8)

Surface filled volume (SFV)

SFV.A/C=0.76
SFV:B/C =0.14

Figure 15—Canopy volume calculation for hypothetical canopy-height values in a 3-by-3 neighborhood.

Forest-Understory Fuel-Bed
Visualization

Comparing differences in return
densities in the understory fuel bed to
the densities of the ground returns in
the same location provide information
on the presence of material like logs
littering the forest floor. The densities
were calculated on a grid with 25-meter
cells. Visualizing this litter as a height
model becomes possible after removing
the overstory from the point data. In
areas without canopy cover, logs on the
forest floor appear in the CHM by
restricting the color ramp to the
2-meters-above-ground height.

To visualize this material under canopy
cover, a fuel-bed height model was
created after Fusion’s Clipdata
command extracted the points below 2
meters from the LAS. The principle is
the same as the one used to create the
CHM. To make the size of the
understory material close to realistic, a
1-meter cell size was used, the smallest
one possible based on the spatial
resolution of the bare-earth model.
Because an output raster for the entire
project area would be too large for most
computers to handle, it was subdivided

into three sections following the same
north/south DOQQ boundaries as the

bare-earth model.

Figure 17 shows examples where forest
conditions are characterized by the
closed and dense canopy of the Riggs
Lake old-growth stands. Compared to
the conditions in figure 18, where the
canopy opened up after the 2004
Nuttall fire, the forest floor here is
covered by many logs easily visible
between the still-standing snags without
removing the canopy.
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Figure 16—The vegetation cover calculation produced by Fusion’s gridmetrics function.

Lidar Preparation
for Field Data
Measurements

Field plot maps for accessible locations
were produced using ArcMap 9.2 and a
software extension called Mapbooks.
Combining these two programs allows
the user to make an indexed book of
maps with spatially referenced points,
plots, imagery, and, in this case, lidar
tiles. The field maps were generated at
1:2,400 and 1:6,000 scales. The lidar
plot-data clouds were interactively
subset using Fusion to a circle

representing a half hectare (39.89-meter
radius). This puts the field plot to be
measured into context and represents it
as a 20th of a hectare (12.62 m radius)
(figure 19). Each subset was referenced
to the plot center points and printed on
the reverse side of the plot map. The
planned field protocol is described by
Wilcox and others (2009).

The details of the way the mapbooks
were created are available in appendix 4.
The points, representing the return
heights of all the 0.05-hectare plots,

were subset from the tiles using a batch

script. Cloudmetrics, representing the
same statistical and height information
calculated by gridmetrics, were derived
for each of the field plots. After the field
season, when the usable plots are known
and their locations have been adjusted
based on the GPS measurements, the
plots will need to be subset again. The
cloudmetrics resulting from those new
data sets will become the basis for
building relationships between the field
and the lidar data.
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Figure 17—A visualization of the elements of the forest floor under a dense canopy: A)the location near Riggs
Lake; B) an oblique view of the complete lidar point cloud; C) ArcGIS grid of the point cloud with the data
restricted to 2 m above the ground and omitting anything at 0.25 m above the ground; D) lidar data cloud that was
the source of image C.
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Figure 18—A collection of graphics visualizing forest-floor woody debris in an area with an open tree canopy.
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Data-Processing
Hardware and
Timeline Summaries

Most of the analysis in this report was
performed using an IBM class dual
processor IV workstation (two Intel
Xeon CPUs 5140, running at 2.33
GHZ) with 3 GB of RAM, a 500-GB
primary hard drive and a 1.5 TB
secondary one. The operating system
was Windows XP Professional (version
2002) with service pack two and Forest
Service image version 6.1e (version
1.2.6). The two main software packages
used during this analysis were Fusion
(version 2.7) and ArcGIS (version 9.3).

g

Table 6 shows the timeline of phases
one and two of this project. Most of the
processing time figures represent how
long it takes to run the different
analyses. The time to write or modify
the scripts is generally small compared
to processing.

Conclusions

This phase two report complements the
phase one briefing stating the
acquisition contracting specifications
(Laes and others 2008). Phase two
included quality assessment and the
automated processing steps to transform
information in the point data to more

accessible raster layers. It also answered
a few more unknowns related to
expected time frames.

The raster parameters derived during
this phase of the project, combined with
the yet-to-be-modeled relationship
between the processed field data and
their corresponding lidar point cloud,
will form the basis for extracting
projectwide information about forest
structure—DBH (diameter at breast
height), basal area, and size classes—
along with biomass and parameters to
populate fuel models.

L - S - WD Feowt arree — P e tremit Fanseb flsten

Figure 19—Plot G12 is utilized to relate data clouds of two sizes spatially to trees on the ground. The cloud on the left is the size of
a field plot: 0.05 hectares or 0.123 acres. The larger subset of the data cloud on the right—0.5 hectares and 1.23 acres—helps field
personnel relate to the smaller data cloud.
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Table 6—Timeline summary for the Pinaleiio Mountains lidar project

Phase 1 Lidar acquisition specification 12 February—June 2008
Project coordination, workshop, and | 1 January—September 2008
conference calls
RFQ bid posting July 2008
RFQ info compilation July 2008
RFQ evaluation August 2008
Field-data protocol development 2 Summer 2008
and testing
Data acquisition 1 End of September 2008
Data delivery Early February 2009

(expected by December 2008)

Phase 2 QA/aC 4 Early March 2009
Project Coordination and Early March—August 2009
conference calls
Data analysis and methods 6 Mid April 2009
development
Aspen delineation 3 April-May 2009
(Including write up)

Creation of field data sheets 1 April-May 2009

Report writing (draft and editing) 7(5+2) May 2009

Field data-protocol development 2 Spring 2009

Field data collection 12 Summer 2009

(CNF)

Workshop preparation 6 June-July-August 2009
Workshop 0.5 17- 19 August 2009

Phase 3 (TBD) Post-processing of field data
Statistical model generation
Model application
Field check the models
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* Appendix 1: Batch Files

Introduction

This appendix is a supplement to “Mapping Vegetation Structure in the Pinaleio Mountains Using Lidar,” which documents
the methodology of phase two of the project. This supplement contains the batch scripts developed to facilitate and automate
lidar processing from the Fusion DOS command line. The scripts appear in smaller type and within an outlined area.

A few prerequisites must be met to run the DOS batch files without editing:

B The path to the Fusion executable (fusion.exe) has to be set in the environment variables. This procedure is explained
in the Fusion manual (McGaughey 2009) and requires administrative privileges on Forest Service imaged
workstations.

B A full understanding of the Fusion command syntax described in the manual is advised.

B Either the folders have to be organized as described here or the batch files must be edited to match computer drive
paths. The listed directory structure can be created in Windows or from the DOS prompt before the scripts are run,
or their creation can be incorporated into the batch files.

These batch files are structured to run from the processing folder in the DOS prompt window unless noted otherwise:
\processing

Start to run the scripts by typing the file name at the DOS prompt, followed by the Enter key, or by right-clicking on the file
from Window Explorer and selecting Open (doing this by accident can have time-consuming consequences, especially for the
catalog file, where an existing catalog.html file gets wiped clean). The advantage of starting script execution from a DOS
window is that the DOS prompt remains open after the run has been completed and any error messages can be checked.

Important note: When editing a batch file, do not open it by right-clicking or double-left-clicking on the file name. This
initializes the run and overwrites previous outputs if they exist. To view the content of a batch script or edit it, right-click and
select Edit from Windows Explorer or open the file from within a text editor.

The scripts starting with “Create....” are used to queue (cycle through) all the files, in this case lidar tiles, and move around the
folders. They call up a “Do...” script that contains the Fusion analysis. After all the tiles have been processed, the “Create...”
script may contain additional functions to merge the processed tiles and export them into ASCII files, which can be imported
into ArcGIS.

Example: “CreateCanopysurface.bat,” which calls “DeCanopy.bat.”

The reason for the “Do...” vprefix before the Fusion descriptor is that the batch files cannot have the same name as existing
Fusion executables.

Avoid spaces in the folder and file names. Neither DOS nor ArcGIS handles them well. DOS can recognize spaces if quotation
marks are used.
Example: canopymodel /outlier:-5,75 “/ground: E:\Products\BareEarth\pm-be-3m.dtm”

Projection information for all the grids and point files:

UTM zone 12

Horizontal units: meters

Vertical units: meters

Horizontal datum: NAD 83
Vertical datum: NAVDS88, Geoid03

*Main document is in separate file.
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Folder Structure
The basic file structure has three main folders: point, processing, and products:

& ) point

E ) processing
_ O LTKp

B ) products
& ) BareEarth
# | ) Canopyheight
# | canopysurface
# ) catalog
# ) density_layers
# |0 density_metrics
# ) fuelbed
# ) gridsurfacestats

) intensity

# ) LTKp_layers
# ) LTKp_metrics
# ) plot-data
H ) report

Details of each folder are listed below

B Qs
= 2 All_points
) mergeddplotclp
) tempdtmplotclip
i) BE-lda
) under2m-ida
= Q) processing
O LTKp

24 | RSAC-0118-Appendix 1



H ) products
= ) BareEarth

) be_2m
) be_2masp
=) be_2mhs
I_) be_2msl
) be_2msiperc
23] ﬂ DOQQ
2 info
E ) temp
SlS] Canopyheight |
fj 2p5m-dtm
I 3m-dtm
) chm_ge25
De
& ) HH-derivatives
) info
||_'—;‘| largeSm
) pm-cht-2pSm
) pm-cht-3m
) pm-cht-25m
& 2 prep-layers
E ) canopysurface
[—;1 2pSm-dtm
1) 3m-dem
F |3 HighestHit
) info
) pr-csm-3m
E ) catalog
® ) catalogl
D) catalog2
) catalog-all
=) density
) intensity
& S catalog-all.zip
= ) density_layers
i) info
= od
) prn_d2min-2Sm
1) pm-dfuel-25m
2 pm-od-25m
) pm-od-2Smnd
= ) density_metrics
) allslices
# |) groundpts
L) underZm

# 1) fuelbed
=l I gridsurfacestats
B ) 25m
& £ 30m
) info
h:f]mmﬂty
E ) LTEp lavers
I aadht
I aveht
2 cover
) ovht
) info
1) baurtht
) maxht
I minht
I modeht
© posht
) ploht
Qs
I p2sht
) p30ht
Do
I pSOht
) péoht
=) p70ht
2 p7sht
3 paoht
I pooht
I p9Sht
ﬁmwﬁmn&s
I skewht
i) stdevht
& |2 under2m
I varianht
=l ) LTKp_metrics
1) From-3mBE
I under2m
= ) plot-data
| Field sheet examples
E ) lidarcloud-0p0Sha
) elevation
_ =) height
# |) Mapbooks
| notes
I protocol
) samplegrid
# ) report
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Quality Control

Catalog function:
The outputs from the catalog include the following, depending on what outputs are requested:

B A summary CSV file
Example: E:\products\catalog\catalog-al\PM_catalog-all.csv

B A summary HTML file
Example: \products\catalog\catalog-all\PM_ catalog-all.html

B An image of the area covered by the tile boundaries
B A pulse density image color coded according to contract specifications

B An intensity image (the catalog function can be executed with different parameters to stretch the color ramp or
change the spatial resolution)

B A flag for tiles that contain lidar point outliers
B A log file (this one includes time stamps to calculate elapsed processing time)

When the /index switch is included, executing the catalog function generates index files for each tile. That slows down the
execution of the first-time run but speeds up further analysis significantly.

DoCatalog.bat

rem create an output folder (\products\catalog\catalog-all)
rem when this file is run the first time, it will create index files which can take many hours
rem for additional run, take out the /index switch and any other part that does not need to be redone

rem create output folders if they do not exist

rem md \products\catalog

rem md \products\catalog\catalog-all

cd \point\las\All_points

rem Check for minimum density, draw the tiles on the intensity bmp

catalog /log:PM-catlog /index /image /drawtiles /coverage /countreturns /density:900,3,8 /firstdensity:900,3,8 /
intensity:900,10,210 /bmp /outlier:2 *.las \products\catalog\catalog-all\PM_catalog-all

cd \processing
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Processing time: The first run took just over 10 hours; subsequent runs to generate output from the catalog batch, when the
index files existed—and the index switch was remarked out of the script—took about an hour and a half to run.

Note: Processing time for additional runs depends on CPU processing speed and the numbers of switches or output products
requested.

The catalog function does not check for the following:
B Opposing flight lines; the \Deliverables\Vectors\Flightlines.shp was modified to check this.

B Scan angle; a few randomly selected LAS tiles were exported to an Access database. Within Access, the scan angles are
summarized with a query.

B Fifty percent flight-line sidelap: this was checked with the USGS consistency code.

Intensity images can also be created with the gridmetrics function, which uses a different algorithm; the results look very noisy

(salt and peppery).
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Lidar Processing

Each of the following sections describes briefly the procedures and lists the scripts that were used. Processing times of more
than one day usually represent 24 hours of uninterrupted computer time (not person times).

Bare-Earth Models at 1, 2.5, and 3-meter Spatial Resolution

Bare-Earth Models for the Entire Project Area at 1, 2.5, and 3 Meters:

These scripts converted the ASCII files created after exporting the bare-earth models delivered by Watershed Sciences from the
ArcGIS grid format (Toolbox > conversion tools > From Raster > Raster to ASCII). After converting the three sections
covering the project area from ASCII to DTM format, the DTMs were merged into a single 1 m and a 3 m bare-earth model.
The 3 m resolution layer was created because the file size of the 1 m model was too large for some of the Fusion follow-up
analysis.

Batchfiles: CreateBeDtm.bat and Do2Dtm. bat
The bare-earth models are stored under \products\bareearth

CreateBeDtm.bat (calls the Do2Dtm.bat)

cd \products\bareearth\3sections\3sections-grids\3sections-asc

dir /b *.asc>filelist.txt

rem Convert the 3 ‘section’ ascii files to dtm

for /F “eol=; tokens=1* delims=,. “ %%i in (filelist.txt) do call \processing\Do2DTM %%i
rem merge the dtms into a 1m bare earth model and a 3 m bare earth model

cd \products\BareEarth\3sections\3sections-dtm

mergedtm /overlap:new /verbose /disk \products\BareEarth\pm-be-1m.dtm *.dtm

mergedtm /overlap:new /verbose /disk /cellsize:2.5 \products\BareEarth\pm-be-2p5m.dtm *.dtm
mergedtm /overlap:new /verbose /disk /cellsize:3 \products\BareEarth\pm-be-3m.dtm *.dtm

Do2Dtm.bat

rem converts the ascii files generated by arcgis to fusion dtms
ASCII2DTM \products\BareEarth\3sections\3sections-dtm%\1.DTM M M 1 12 2 2 %1.ASC

DOQQ-Sized Bare-Earth Model at 1 Meter

These subsets were created for the LTKp gridmetrics calculations (see that section). The LTKp processor is designed to keep
multiple grids in memory but the projectwide grid files, and those that divided the area into three sections were still too large
for Fusion and the processing computer. Before the DOQQ-sized DTMs could be created, the ArcGIS grids needed to be
clipped to the DOQQ limits (ArcToolbox > Data Management tools > Raster > Raster Processing > Clip). After the DOQQ
bare-earth models were subset, they needed to be converted to ASCII files.
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To generate the DOQQ-sized 1 m DTM bare-earth models, run

\products\BareEarth\DOQQ\doqg-asc\create2dtm.bat (calls Do2Dtm.bat)

cd \products\BareEarth\DOQQ\doqgq-asc
dir /b *.asc>filelist.txt

for /F “eol=; tokens=1* delims=,. “ %%i in (filelist.txt) do call \products\BareEarth\DOQQ\dogqg-asc\Do2DTM %%i

\products\BareEarth\DOQQ\dogqg-asc\Do2DTM.bat

ASCII2DTM \products\BareEarth\DOQQ\doqq-dtm\%1.DTM M M 1 12 2 2 \products\BareEarth\DOQQ\doqg-
asc\%1.ASC

The output is stored under \products\bareearth\3sections

Processing time: about 1 day

Canopy Models at 3 -MeterSpatial Resolution

These scripts produce the canopy surface model (CSM) and canopy height model (CHM). The difference between the two is
that the CHM is normalized to the bare-earth model and represents heights above ground instead of elevations as the CSM

does.

CSM is stored under \products\canopysurface
CHM is stored under \products\canopyheight

CreateCanopysurface.bat (Calls docanopy.bat)

cd \POINT\LAS\ALL_POINTS
rem dir /b *.las>filelist.txt

rem loop through all LAS files in folder and do processing
for /F “eol=; tokens=1* delims=,. “ %%i in (filelist.txt) do call \processing\docanopy %%i

cd \products\canopyheight\3m-dtm

mergedtm /overlap:new \products\canopyheight\PM-CHT-3m.dtm *.dtm
cd \products\canopyheight\

dtm2ascii PM-CHT-3m.dtm \products\canopyheight\pm-cht-3m.asc

cd \products\canopysurface\3m-dtm

mergedtm /overlap:new \products\canopysurface\PM-CSM-3m.dtm *.dtm
cd \products\canopysurface\

dtm?2ascii PM-CSM-3m.dtm \products\canopysurface\pm-CSM-3m.asc

cd \processing
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docanopy.bat

rem Canopy surface model
canopymodel \Products\CanopySurface\3m-dtm\%1_CSM.dtm 3 m m 1 12 2 2 %1.las

rem canopy height
canopymodel /outlier:-5,75 “/ground:E:\Products\BareEarth\pm-be-3m.dtm”

\Products\CanopyHeight\3m-dtm\%1_CHT.dtm 3 m m 1 12 2 2 %1.las

Processing time: 2 days

Canopy Models at 2.5-Meter Spatial Resolution
This is necessary to generate the gridsurfacestat models—surface area and surface volume calculations—with the same cell size
as the gridmetrics output models (i.e., 25 m)

CreateCanopysurface2p5.bat (Calls docanopy2p5.bat)

cd \POINT\LAS\ALL_POINTS

rem loop through all LAS files in folder and do processing
for /F “eol=; tokens=1* delims=,. “ %%i in (filelist.txt) do call \processing\docanopy2p5 %%i

rem merge canopy products

cd \products\canopyheight\2p5m-dtm

mergedtm /overlap:new \products\canopyheight\PM-CHT-2p5m.dtm *.dtm
cd \products\canopyheight\

dtm2ascii PM-CHT-2p5m.dtm pm-cht-2p5m.asc

rem merge canopy products
cd \products\canopysurface\2p5m-dtm
rem mergedtm /overlap:new \products\canopysurface\PM-CST-2p5m.dtm *.dtm

cd \products\canopysurface\
dtm2ascii PM-CSM-2p5m.dtm pm-CSM-2p5m.asc

cd \processing

docanopy2p5.bat

rem CSM @ 2.5m
rem Canopy surface model
canopymodel \Products\CanopySurface\2p5m-dtm\%1_CSM.dtm 2.5 m m 1 12 2 2 %1.las

rem CHM @ 2.5m

rem the 2.5 m is needed to create surface and volume derive models at the same 25m cell size
rem canopymodel /outlier:-5,75 “/ground:E:\Products\BareEarth\pm-be-2p5m.dtm”
\Products\CanopyHeight\2p5m-dtm\%1_CHT.dtm 2.5 m m 1 12 2 2 %1.las
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Volume and Surface Models Derived from 2.5-Meter Canopy Height Model (CHM) at 25-Meter Spatial Resolution
Fusion command required to create the surface volumes and surfaces is not yet part of the released version of Fusion. It will be
available after V. Kane’s (University of Washington) publications to fulfill the requirements for his PhD are accepted.

This computation is based on the 2.5 meter CHM, from which it creates a multiple neighborhood (which is set at 10).

This analysis calculates volumes in the following way:

B Assigning the maximum height within the 10-by-10-block neighborhood to all the cells (potential volume under the
surface at 25m)

B Assigning the sum of the 10-by-10 CHM to the 25 m block (the volume under the canopy surface)
B Calculating the ratio of the volume to the potential volume (the filled volume)
This analysis also calculates the
B Top of surface area
B Surface area ratio (top of surface area / by planimetric surface area)
These metrics provide indications of the overall canopy structure and complexity;
CreateGridSurfaceStats25.bat and Do2Ascii.bat

CreateGridSurfaceStats25.bat

eridsurfacestats /verbose \products\Canopyheight\pm-cht-2p5m.dtm \products\gridsurfacestats\25m\pm-area25.dtm 10
eridsurfacestats /verbose /area \products\Canopyheight\pm-cht-2p5m.dtm \products\gridsurfacestats\25m)\
pm-area25.dtm 10

cd \products\gridsurfacestats\25m
dir /b *.dtm>filelist.ext

for /F “eol=; tokens=1* delims=,. “ %%i in (filelist.txt) do call \processing\Do2ASCII %%i

Do2Ascii.bat

DTM2ASCII %1.DTM %1.ASC
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Store under created output \products\gridsurfacestats\

pm-area25_max_height 25 pm-maxht-25 m Maximum heightin the 10-by-10
block from the CHM
pm-area25_potential_ 25 pm-potvol-25 m Maximum potential volume under
volume the canopy height surface using
the maximum height in the cell
pm-area25_surface_ 25 pm-sv-25 m Volume under the canopy height
volume surface computed from the CHM
pm-area25_surface_ 25 pm-svr-25 m Filled volume pm-sv / pm-potvol
volume_ratio Ratio of the volume under the
canopy height surface divided
by the volume under the surface
defined by the maximum height in
the cell
pm-area25_surface_area |25 pm-sa-25m Area of the canopy height surface
(only created with /area Indicative of the outer surface
switch) ruggedness
pm-area25_surface_area_ |25 pm-sar-25 m Pm-sa /900 m? Ratio of the area
ratio of the canopy height surface
divided by the cell area. Canopy
roughness or rumple index (Parker
and others 2004)
Articles:

Jenness (2004)

Parker and Russ (2004)
Parker and others(2004)
Kane and others (2008)

Processing time from start of batch file to ArcGIS grids: approximate 1 hour

Gridmetrics Models at 25-meter Spatial Resolution
The gridmetrics function requires the input of the 1 m bare-earth model. Using the function on the delivered tiles produces
edge effects along their sides. This occurs because the tiles are generated in geographic coordinates. After projecting the tiles,
slivers with no data remain along the edges. Grid cells overlapping these cells should be calculated based on the returns from
the partial cells spanning the two adjacent tiles. When the statistics are calculated on cells containing partial data from either
tile only, the edge effects become visible after merging the grids to the project area. These effects can be avoided by virtually
reducing the original lidar tiles into smaller ones than the originals while also defining a buffer around the new smaller virtual
tiles. The buffer and the gridcell width/height (i.e., the size of the new virtual tile) should be multiples of the chosen cell size.
Fusion’s LTKp tool helps write the script for this process. These batch files are stored under \processing\LTKp
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The gridmetrics are calculated at 2 m above the ground because they are designed to look at the forest canopy structure. The
only exception is the canopy cover, which is calculated at 3 m above the ground. A larger cell size than the CHM is required
because these metrics relate to forest structure. At smaller cell sizes, there might not be enough points to derive valid statistical
information. The statistics characterize the presence of a tree, not the forest or vegetation cover. When the cell size is too small,
the distribution of cover values tends to be bimodal with values near 0 and 100 percent and few values between. The cell size
should be larger than individual tree crowns, especially for cover calculations (McGaughey 2009).

The cell size of 25 m was selected since it is close to the plot size of the field data acquisition (0.05 ha). The field data (to be
acquired during the summer of 2009) will be used to establish forest relationships with the lidar data. All the gridmetrics are

calculated at 2 m above the ground.

dometrics_25m.bat and doL TKcell. bat
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E \ponilas\Al points\32109E 710612963418 607896.85 _3607527,87 1008.35 60908537 60836 35 2257
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Batch e for prepiocessing | Clew | £t | Cieste | Browss |
~ For sach buffered ts:

Batch fie for e processing  [E-\processng\LTKp\doL Thcel bat Clear | Ect | Ciette| Browess |
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dometrics_25m.bat (calls doLTKcell.bat)
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@ECHO OFF
REM LTKProcessor -- Version 1.20
REM Batch file created by LTKProcessor on 03/30/09 at 15:21:23

REM Data processing extent--LL(586800.00,3605850.00) UR(614800.00,3627575.00)
REM Analysis tile grid is 29 columns by 22 rows
REM Analysis cell size is: 25.000000

REM set working drive and directory
E:
CD E:\processing\LTKp

ECHO Processing analysis tile for column: 1 row: 1 (TILE_C00001_R00001)

ECHO Tile 1 of 638

CALL “E:\processing\LTKp\doLTKcell.bat” TILE_C00001_R00001 586800.0000 3605850.0000 587800.0000
3606850.0000 586800.0000 3605850.0000 587900.0000 3606950.0000 “E:\processing\LTKp\LTKP_filelist.txt”
100.0000 1000.0000 1000.0000

ECHO Processing analysis tile for column: 1 row: 2 (TILE_C00001_R00002)

ECHO Tile 2 of 638

CALL “E:\processing\LTKp\doLTKcell.bat” TILE_C00001_R00002 586800.0000 3606850.0000 587800.0000
3607850.0000 586800.0000 3606750.0000 587900.0000 3607950.0000 “E:\processing\LTKp\LTKP_filelist.txt”
100.0000 1000.0000 1000.0000

ECHO Processing analysis tile for column: 1 row: 3 (TILE_C00001_R00003)

ECHO Tile 3 of 638

CALL “E:\processing\LTKp\doLTKcell.bat” TILE_C00001_R00003 586800.0000 3607850.0000 587800.0000
3608850.0000 586800.0000 3607750.0000 587900.0000 3608950.0000 “E:\processing\LTKp\LTKP_filelist.txt”
100.0000 1000.0000 1000.0000

ECHO Processing analysis tile for column: 29 row: 21 (TILE_C00029_R00021)

ECHO Tile 637 of 638

CALL “E:\processing\LTKp\doLTKcell.bat” TILE_C00029_R00021 614800.0000 3625850.0000 615800.0000
3626850.0000 614700.0000 3625750.0000 614799.8100 3626950.0000 “E:\processing\LTKp\LTKP_filelist.txt”
100.0000 1000.0000 1000.0000

ECHO Processing analysis tile for column: 29 row: 22 (TILE_C00029_R00022)

ECHO Tile 638 of 638

CALL “E:\processing\LTKp\doLTKcell.bat” TILE_C00029_R00022 614800.0000 3626850.0000 615800.0000
3627850.0000 614700.0000 3626750.0000 614799.8100 3627551.1300 “E:\processing\LTKp\LTKP_filelist.txt”
100.0000 1000.0000 1000.0000

@ECHO ON
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doLTKecell.bat

REM Tile processing batch file created by LTKProcessor on 03/26/09 at 11:19:37

REM Expected command line parameters:

REM %1 Name of the buffered tile containing LIDAR data

REM %2 Minimum X value for the unbuffered tile

REM %3 Minimum Y value for the unbuffered tile

REM %4 Maximum X value for the unbuffered tile

REM %5 Maximum Y value for the unbuffered tile

REM %6 Minimum X value for the buffered tile

REM %7 Minimum Y value for the buffered tile

REM %8 Maximum X value for the buffered tile

REM %9 Maximum Y value for the buffered tile

REM The buffered tile file name looks like this: TILE_C00001_R00002. The row and column numbers
REM specify the tile location with the origin of the row and column coodinate system in the lower left

REM Initially, the values for %2, %3, %4, %5 can be used to clip data products produced using the buffered tile

REM Insert commands that use the original tile corners before the the block of SHIFT commands

REM
REM After the 4 SHIFT commands, variables %6, %7, %8, %9 contain the following values:

REM %6 Name of the text file containing a list of all data files
REM %7 Buffer size

REM %8  Width of the unbuffered analysis tile

REM %9 Height of the unbuffered analysis tile

REM SHIFT command moves command line parameters one position. For example, %10 moves to %9.
REM This is necessary because DOS cannot directly reference more than 9 command line parameters
REM since %10 would be interpreted as %1.

REM Shift last four variables (%10-%14) into positions %6-%9
SHIFT /6
SHIFT /6
SHIFT /6
SHIFT /6

REM Insert commands that use the buffer width and all data files after the block of SHIFT commands

eridmetrics /minht:2 /verbose /gridxy:%2,%3,%4,%5 /buffer:%7 /outlier:-2,100 \products\bareearth\be*.dtm 3 25 \
products\LTKp_metrics\%1_metrics.csv %6

The output from this process produces a CSV file for each of the virtual tiles with 31 columns. The outputs are generated at a
25 m cell size and are stored at \products\LTKp_metrics

The following scripts extract the columns from the CSV files to grids:
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Buildlayers.bat (calls extractmetric.bat )

rem extract metrics from CSV files and merge into a single coverage

rem 2plus refers to minimum height

rem 25m = cellsize

rem above3 = height break for cover calculation

rem this bat file is run from dos e:\processing\LTKp\

rem it calls extractmetric.bat which in his turns calls doextractmetric.bat

rem the 3 variables after ‘extracmetric’ on the lines below are the %1 %2 and %3 user needed inputs

cd \processing\ltkp

call extractmetric 5 pulsecnt_25m 1

call extractmetric 6 minht_2plus_25m 1

call extractmetric 7 maxht_2plus_25m 1

call extractmetric 8 aveht_2plus_25m 1

call extractmetric 9 modeht_2plus_25m 1
call extractmetric 10 stddevht_2plus_25m 1
call extractmetric 11 varianceht_2plus_25m 1
call extractmetric 12 CVht_2plus_25m 1

call extractmetric 13 skewnessht_2plus_25m 1
call extractmetric 14 kurtosisht_2plus_25m 1
call extractmetric 15 AADht_2plus_25m 1
call extractmetric 16 PO5ht_2plus_25m 1
call extractmetric 17 P10ht_2plus_25m 1
call extractmetric 18 P20ht_2plus_25m 1
call extractmetric 19 P25ht_2plus_25m 1
call extractmetric 20 P30ht_2plus_25m 1
call extractmetric 21 P40ht_2plus_25m 1
call extractmetric 22 P50ht_2plus_25m 1
call extractmetric 23 P60ht_2plus_25m 1
call extractmetric 24 P70ht_2plus_25m 1
call extractmetric 25 P75ht_2plus_25m 1
call extractmetric 26 P80ht_2plus_25m 1
call extractmetric 27 P90ht_2plus_25m 1
call extractmetric 28 P95ht_2plus_25m 1
call extractmetric 29 cover_above3_25m 100

Extracmetric.bat (calls DoExtractmetric.bat)

@echo off
REM extract a specific metric from CSV files produced by Gridmetrics

if “%1”=="" goto syntax
if “%2”=="" goto syntax
if “%3”=="" goto syntax

goto process

:syntax

echo extractmetric column name multiplier

echo column is the column number in the GridMetrics CSV output

echo name is the name used for the merged output DTM file (don’t include the .dtm extension)
echo multiplier used for each cell value (use 100 for cover col 29, 1 for all else)

coto end

:process
@echo on
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REM do the extraction from each tile
REM cd \products\LTKp_metrics
cd \products\LTKp_metrics\under2m

dir /b *.csv > csvlist.txt

rem loop through all CSV files in folder and do processing
for /F “eol=; tokens=1* delims=,. “ %%i in (csvlist.txt) do call \processing\LTKp\doextractmetric %%i %1 %3

rem merge tiles...ASCII raster format
REM cd \products\LTKp_layers

cd \products\LTKp_layers\under2m
mergeraster /overlap:new %2.asc *_tile.asc

rem convert ASCII raster file to DTM
ascii2dtm %2.dtmmm 1 12 2 2 %2.asc

rem delete tiles
del *_tile.asc

cd \processing\LTKp

:end
@echo on

DoExtractmetric.bat

rem extract cover values from CSV files to ASCII raster, then convert to DTM format

REM CSV2Grid /multiplier:%3 %1.csv %2 \Products\LTKp_layers\%1_tile.asc
CSV2Grid /multiplier:%3 %1.csv %2 \Products\LTKp_layers\under2m\%]1 _tile.asc

The 25 m grids for the entire project area are stored under \products\LTKp_layers

Here are the created grids:
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Row

Column
Return count
above 2m

4 First-return

count above 3m

5 Total first- pulsecnt_25m 25 pulsecnt Number of first returns (pulses)

return count in cell.

6 Minimum minht_2plus_25m 25 minht Minimum height of all returns
located 2 m or more above the
ground. Values in this grid should
be close to 2 m. When they are
higher, it indicates there were
no bare-earth returns or the
vegetation cover is very dense,
preventing the laser pulse from
penetrating to the ground.

7 Maximum maxht_2plus_25m 25 maxht Maximum height of all returns
located 2 m or more above the
ground.

8 Mean aveht_2plus_25m 25 aveht Average height of all returns 2 m
or more above the ground.

9 Mode modeht_2plus_25m 25 modeht Mode value of all returns for all
returns 2 m or more above the
ground.

10 Standard stddevht_2plus_25m |25 stdevht Standard deviation of height for

Deviation all returns 2 m or more above the
ground.

" Variance varianceht_2plus_ 25 varianht Variance of height for all returns

25m 2 m or more above the ground.

12 Coefficient of CVht_2plus_25m 25 cvht Coefficient of variation of height

variation for all returns 2 m or more above
the ground.

13 Skewness skewnessht_2plus_ |25 skewht Skewness of the distribution

25m of heights for all returns 2 m or
more above the ground.
Negative skewness values
indicate that the distribution of
height values in the cell is shifted
to the right of the mean and the
mean<median<mode. Positive
skewed values reflects a shift to
the left of the mean.

14 Kurtosis kurtosisht_2plus_25m | 25 kurtht Kurtosis of the distribution of

heights for all returns 2 m or
more above the ground.
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15 AAD AADht_2plus_25m 25 aadht Average absolute deviation of
the heights for all returns 2 m or
more above the ground

16 P05 PO5ht_2plus_25m 25 p05ht Xth percentile height value for

17 P10 P10ht_2plus_25m 25 p10ht all returns 2 m or more above the

— — ground

18 P20 P20ht_2p|us_25 m 25 p20ht Percentile heights are

19 P25 P25ht_2plus_25m 25 p25ht interpreted as follows:

20 P30 P30ht_2plus_25 m 25 p30ht X% of the returns are below the

— — height,

21 P40 P40ht_2plus_25m 25 p40ht (100 — X)% are above

22 P50 P50ht_2plus_25m 25 p50ht

23 P60 P60ht_2plus_25m 25 p60ht

24 P70 P70ht_2plus_25m 25 p70ht

25 P75 P75ht_2plus_25m 25 p75ht

26 P80 P80ht_2plus_25m 25 p80ht

27 P90 P90ht_2plus_25m 25 p90ht

28 P95 P95ht_2plus_25m 25 p95ht

29 Density cover_above3_25m |25 cover Proportion of the first returns

(decimal occurring 3 m or higher above
percent cover) the ground or the number of
pulses with a first return above
3 min the cell divided by the total
number of pulses in the cell.
30 Center X
31 Center Y
Articles:
Heurich and Thoma 2008

Hudak and others 2008

Means and others 2000

Processing time: 4 to 5 days

B Prep work to clip the 1 m bare-earth grids into smaller chunks and convert them to DTMs: 2 hours

B Running the LTKp batch files and extracting the grids: 3 to 4 days

B Importing the ASCII files into ArcGIS: 2 hours

B Generating gridmetrics derivatives: E ratio (stored under Canopyheight): 10 minutes
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Obstacle Density at 25 Meter Spatial Resolution

Preparation Work: Ground Point Conversion to LDA Files
The XYZ text files with the ground point returns are only used during the understory obstacle-density calculations. This batch
file is run within the delivered folder.

CreateGptsConvert.bat (calls DoGptsConvert.bat)

dir /b *.asc>asclist.txt
for /F “eol=; tokens=1* delims=,. “ %%i in (asclist.txt) do doGptsConvert.bat %%:i

rem move the Ida files to the working point directory
move *.Ida \point\las\BE-lda

DoGptsConvert.bat

asciiimport PM_bepts.importparam %1.asc %1_ground_pts.lda

The PM_bepts.importparam can be created by importing one of the ASCII files through the Fusion Windows interface:
Tools> Dataconversion>import generic ASCII lidar data.

Density Metrics at 25 Meter Cell Size:

Extract the returns representing the understory (2 m or less above the ground) from the LAS files. This slice contains both the
ground points and the understory returns, which are calculated by subtracting the ground densities from the below-2 m
densities. The scripts to extract and process the below-2 m data from the LAS tiles as well as calculate ground point densities
are these:

CreateDensityMetrics.bat, DoDensityMetrics.bat and DoDensitymetrics-gpts. bat.
The output is stored in:

\products\density_metrics\groundpts
\products\density_metrics\under2m

After calculating the densities for the below-2 m and the ground point tiles, merge the tile-sized DTMs to create area wide
project grids (which show edge effects) and export them to ASCII files. These files can be imported into ArcGIS.

The project-size ASCII files and grid are stored in \prodcuts\density_layers

CreateDensitySlice.bat (calls DoDensitySlice.bat and DoDensitySlice-gpts.bat)

cd \POINT\LAS\ALL_POINTS

rem create a filelist
dir /b * las>filelist.txt

rem loop through all LAS files in folder and do processing
for /F “eol=; tokens=1* delims=,. “ %%i in (filelist.txt) do call \processing\dodensityslice %%i
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cd \POINT\LAS\BE-Ida

rem create a filelist from lda files converted from *.txt

dir /b *.1da>filelist.txt

for /F “eol=; tokens=1* delims=,. “ %%i in (filelist.txt) do call \processing\dodensityslice-gpts %%i

cd \products\density_metrics\under2m

mergedtm /overlap:new \products\density_layers\PM-density-2min-25m.dtm *_total_returns.dtm

dtm?2ascii \products\density_layers\PM-density-2min-25m.dtm \products\density_layers\PM-density-2min-25m.asc
cd \products\density_metrics\groundpts

mergedtm /overlap:new \products\density_layers\PM-density-gpts-25m.dtm *_total_returns.dtm

dtm?2ascii \products\density_layers\PM-density-gpts-25m.dtm \products\density_layers\PM-density-gpts-25m.asc

cd \processing

DoDensityMetrics.bat

rem density metrics for understory (<= 2m above groundsurface) will be first slice

rem the metrics are calculated in 2m height slices (intervals) with maximum height @50m at 25m cellsize

densitymetrics /maxsliceht:50 /outlier:-1,50 \Products\BareEarth\pm-be-3m.dtm 25 2 \Products\density_metrics\
allslices\%1_density %1.las

rem create densitymetrics from all points for understory only (this creates a separate CSV file with the return count for
this slice)

densitymetrics /maxsliceht:2 /outlier:-1,2 \Products\BareEarth\pm-be-3m.dtm 25 2 \Products\density_metrics\
under2m\%1_density %].las

This batch file creates densitymetrics for all tiles in 2 m intervals up to 50 m above the ground. These densities were calculated
for all the lidar tiles but were not processed any further.

DoDensityMetrcis-gpts.bat

REM density metrics for groundpoints (to be used for obstacle density calculation)
REM when this density is subtracted from the 2m above groundsurface slice (under 2m), the returns of the fuelbed are
determined)

REM these densities are used to calculate the obstacle density in the fuelbed (understory)
REM (Seielstad and Queen, JOF, 2003)

densitymetrics /maxsliceht:2 /outlier:-1,2 \Products\BareEarth\pm-be-3m.dtm 25 2 \Products\density_metrics\
groundpts\%1_density %1.lda

Article:
Seielstad and Queen 2003
Notes

1. The obstacle-density ratio is created in ArcGIS by generating the density for the fuel bed (below-2 m densities—ground-
point densities) and normalizing the returns to the sum of the fuel bed and ground-point returns. The expected values
range between 0 and 1. In this project, the values were much higher along the tile edges because of the edge effects. These
values were replaced with NoData.
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2. The output from the DoDensityMetrics.bat is stored in the \products\density_metrics folder. The merged DTMs,
converted ASCII files, and ArcGIS grids are stored in the density_layers folder.

Processing time: 2 days

Fuel-Bed Visualization under Canopy at 1-Meter Spatial Resolution

The downed logs in open terrain were visualized by restricting the height of the CHM to 2 m above the ground. To visualize
the logs and other material in the understory (lower than 2 m above the ground) these returns had to be extracted from the
return point cloud before being rasterized. Clipping the all_points LAS tiles with the Clipdata command accomplished this
task.

Prep Work: Extracting the 2-Meters Above Ground from the LAS Point Data Tiles

Clipdata is generally used to spatially subset lidar point data, but since it has a maximum height switch, it can also extract a
height interval from the point data. This script is different from the previous ones because each line has the spatial extent for
each of the included tiles. Those coordinate values were extracted from the CSV file created by the catalog function during
quality assessment. Every single line of the script was concatenated in Excel and saved to a text file: Clip2minfromlas.bat.

The output files are stored in the \point\las\under2m-Ida\ folder

Clip2minfromlas.bat

clipdata /shape:0 /dtm:pm-be-3m.dtm /zmax:2 /index 32109E7101 las \point\las\under2m-1da\32109E7101 min2
605538.11 3608889.39 606725.5 3610286.71

clipdata /shape:0 /dtm:pm-be-3m.dtm /zmax:2 /index 32109E7102.las \point\las\under2m-lda\32109E7102min2
606710.79 3608901.1 607898.37 3610299.35

clipdata /shape:0 /dtm:pm-be-3m.dtm /zmax:2 /index 32110G1424.las \point\las\under2m-1da\32110G1424min2
591325.55 3623992.97 592509.31 3625389.46

clipdata /shape:0 /dtm:pm-be-3m.dtm /zmax:2 /index 32110G1425.las \point\las\under2m-1da\32110G1425min2
592492.66 3624003.79 593680.32 3625795.49

Creation of Surface Models for the Understory Fuel Bed

The scripts to process the data are basically the same as those to generate the CSM and CHM, but to keep the output at 1 m
spatial resolution, the project area needed to be divided into smaller sections. The same three sections as the original delivered
bare-earth grids were created.

CreateFuelbedSurface2minus.bat and DoFuel bed.bat

The output is stored in \products\fuelbed
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CreateFuelbedSurface2minus.bat (calls DoFuelbed.bat)

rem this batchfile was recreated from individual pieces

rem the original process was not from this batch file

rem if problems occur, check the file directory structure syntax, space and forward slashes or back slashes

rem the final folder structure and overall file-naming convention was changed after the dtms were created from the
under2m.lda files

rem before the FHM and FSM can be ceated at 1 m cell size, the under2m points have to be subset from the las
pointcloud

rem the batch file to do this is stored at \point\las\All_points\clip2Zminfromlas.bat (explanation of how this was created see
readme worksheet in \point\las\All_points \fileXY.xls)

ICHJ***********************************************************************************

rem PART 1: process the individual point tiles to create FSM and FHM dtm for each point tile

renl***********************************************************************************

cd \POINT\LAS\under2m-lda
dir /b *.1da>filelist.txt

rem loop through all LAS files in folder and do processing
for /F “eol=; tokens=1* delims=,. “ %%i in (filelist.txt) do call \processing\DoFuelbed %%i

renl***********************************************************************************

rem PART 2: FSM

renl***********************************************************************************

rem merge fuelbed surface products

cd \products\fuelbed\Fuelbed-FSM\tiled-dtm

rem the following lines takes a long time to run and depending on computer memory might crash

mergedtm /disk /overlap:new \products\fuelbed\Fuelbed-FSM\PM-FSM-1m.dtm *.dtm

rem the following 3 lines create smaller files but divide the project area in 3 ‘sections’
rem the ‘DOQ#’ part of the file name is specific to Pinalefios project

cd \products\fuelbed\Fuelbed-FSM
dir /b dog?*.dem>filelist.ext
rem convert fuelbed surface model (FSM) dtms to ascii which can be imported into arcgis

for /F “eol=; tokens=1* delims=,. “ %%i in (filelist.txt) do call Do2ascii %%i
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renl***********************************************************************************

rem PART 3: FHM

renl***********************************************************************************

rem merge fuelbed height products
cd \products\fuelbed\Fuelbed-FHM\tiled-dtm

rem the following processing line takes a long time to run and depending on computer memory might crash
mergedtm /disk /overlap:new \products\fuelbed\Fuelbed-FHM\PM-FHM-1m.dtm *.dtm

rem the following 3 lines create smaller files but divide the project area in 3 ‘sections’

cd \products\fuelbed\Fuelbed-FHM

dir /b dog?*.dtm>filelist.txt

rem convert fuelbed height model (FHM) dtms to ascii which can be imported into arcgis
for /F “eol=; tokens=1* delims=,. “ %%i in (filelist.txt) do call Do2ascii %%i

cd \processing

DoFuelbed.bat

rem FSM and FHM are created at 1 meter, larger cell sizes would overestimate the size of the logs (1m cells overestimates
them already)

rem FuelBed surface model (FSM) 2meters above groundsurface

canopymodel \Products\fuelbed\fuelbed-FSM\tiled-dtm\%1_FSM.dtm 1l m m 1 122 2 %1.1da

rem FuelBed Height (FHM) 2 meters above groundsurface

canopymodel /outlier:-5,2 “/ground:E:\Products\BareEarth\pm-be-3m.dtm” \Products\fuelbed\fuelbed-FHM \tiled-
dtm\%1_FHM.dtm 1 mm 11222 %1.1da

Note: The 3 sections of the fuel bed output are at 1 m spatial resolution while the “CWD-2 m” is at 2m. The 2m grids were
created to generate a single grid for the entire project. The CWD layer was created directly from the highest-hit and bare-earth
deliverables before any Fusion processing. Creating a CWD layer at 1 m is possible by dividing the project-data deliverables
into three separate sections. For visualization purposes, the 2 m grids work OK. For deriving metrics, they overestimate the size
of logs and other understory material. The 1 m fuel bed grids show the understory material in both open terrain and areas
where canopy cover obscures what is close to the ground.

Processing time: 2 days
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Subsets of the Field Plots from the LAS Files

Data preparation:
B Intersecting the buffer plot centers with the boundaries of the LAS tiles and the DOQQs
B Merging the LAS tiles and bare-earth DOQQs when the plots overlap boundaries
Processing notes:
B The 1m bare-earth model covering the project area in three sections was too large for the Clipdata command.
B The exact location of the plots will be adjusted after the field season based on the GPS measurements. The location of
some of the plots may need changing to accommodate field conditions described in the field protocol (Wilcox and
others 2009). Subsetting the plots from the lidar tiles needs to be repeated after the final plot-center locations are

available.

The plots were subset twice with two separate batch files: once keeping the elevations of the lidar points and once normalizing
the elevations to the bare ground and converting the lidar points to the height measurements.

The batch file to calculate the height of the lidar points looks like this (output files have the plotID and an E in the file name):

clipplotelevations.bat

clipdata /shape:1 /index 32110G1423.1as B5-E 590925.66 3624184.72 590950.9 3624209.96
clipdata /shape:1 /index 32110F1203.1as C5-E 590925.67 3623184.7 590950.91 3623209.94
clipdata /shape:1 /index 32110F1204.1as C55-E 591425.66 3623684.71 591450.9 3623709.95
clipdata /shape:1 /index 32109F8210.las D19-E 604925.42 3622184.54 604950.66 3622209.78

clipdata /shape:1 /index F7111-F8215.1da F69-E 605425.43 3620684.49 605450.67 3620709.73
clipdata /shape:1 /index F7116-F8220.l1da G69-E 605425.45 3619684.46 605450.69 3619709.7
clipdata /shape:1 /index F7116-F8220.1da H69-E 605425.47 3618684.43 605450.71 3618709.67

The batch file to calculate the height of the lidar points looks like this (output files have the plotID and an H in the file name):

clipplotheights.bat

clipdata /shape:1 /dtm:be_G14.dtm /height /index 32110G1423.1as B5-H 590925.66 3624184.72 590950.9 3624209.96

clipdata /shape:1 /dtm:be_F12.dtm /height /index 32110F1203.1as C5-H 590925.67 3623184.7 590950.91 3623209.94

clipdata /shape:1 /dtm:be_F12.dtm /height /index 32110F1204.1as C55-H 591425.66 3623684.71 591450.9
3623709.95

clipdata /shape:1 /dtm:be_F82.dtm /height /index 32109F8210.1as D19-H 604925.42 3622184.54 604950.66
3622209.78

clipdata /shape:1 /dtm:beF82-F71.dtm /height /index F7111-F8215.1da F69-H 605425.43 3620684.49 605450.67
3620709.73

clipdata /shape:1 /dtm:beF82-F71.dtm /height /index F7116-F8220.1da G69-H 605425.45 3619684.46 605450.69
3619709.7

clipdata /shape:1 /dtm:beF82-F71.dtm /height /index F7116-F8220.1da H69-H 605425.47 3618684.43 605450.71
3618709.67

46 | RSAC-0118-Appendix 1



The output files from the height subsets are used to calculate the cloudmetrics. These metrics are figured at the canopy level
only, including the data points 2 m above the ground (indicated by the /htmin switch), just line the gridmetrics ones. An
estimate of the canopy cover is included by using the /above switch. The statistics are written to a single CSV file in the

\products\plot-data\lidarcloud-0p05ha\height folder.

Docloudmetrics.bat

cloudmetrics /htmin:2 /above:3 /new \products\plot-data\lidarcloud-0p05ha\height\*.1da \products\plot-data\lidarcloud-
0p05ha\height\plotH-metrics.csv

Processing time: 1 day
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Appendix 2: Lidar-Processing Output Files

List of commonly used project file extensions

tif (also .tfw)

Image file format viewable in Fusion, ArcGIS,
and Erdas Imagine

.bmp (also .bmpw)

Image file format viewable in Fusion, ArcGIS,
and Erdas Imagine

ip2, jpg (also .j2w

Compressed image file format viewable in

Imagine when displaying images or grids

and .jpgw) Fusion, ArcGIS, and Erdas Imagine
i (1w Image file format viewable in ArcGIS and
mg 19 Erdas Imagine
L.aux _F|Ie created by ArcGIS when displaying Can be deleted, ArcGIS will recreate
images or grids
rrd Pyramid file created by ArcGIS or Erdas Speeds display of imagery, can be deleted and

recreated

.sbx, .shp, .shx, .dbf,
.prj, .sbn,

Files that comprise an ArcGIS shapefile

.shp, .sbx, and .dbf mandatory, others are
optional

Binary lidar point data files viewable in Fusion,

LAS-files can be opened as a table in ArcMap

comma

las, .Ida - - . with LAS-reader
not viewable in ArcGIS or Erdas Imagine. http://geocue.com/utilities/lasreader.html
. Lidar data index files created by Fusion for use
Adx, .Idi . :
with .las and .Ida files
Binary digital terrain models created by
.dtm Fusion, not viewable in ArcGIS or Erdas
Imagine
.adf Files that comprise an ArcGIS grid
. Text file in ESRI gridformat Usqd for moving .dtm or .csv.flles generated in
Fusion to grids in ArcGIS or vice versa
Comma separated values; textfile in tabular ~ |Used to generate fusion grids that have
.CSV format in which each value is separated by a |(cells with negative values. dtm’s can't store

negative values
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Quality Assessment

Catalog-all.html

Summary of Fusion QA

products\catalog\catalog-all

Catalog-all.csv

Per tile listing of minXYZ, maxXYZ, count by return
number, point density and number of points

\products\catalog\catalog-all

PM_first_return_density-900-3p0-8.bmp

First-return (renamed output from catalog10.bat) 30.0 \oroducts\catalog\densit
. r nsi
density images PM_first_return_density-900-1p5-8.bmp productsicatalogidensity
(renamed output from catalog14.bat)
PM_catalog5_intensity-2p5m.bmp 25
o PM_catalog4_intensity-3m.bmp 3.0 _ _
Intensity images - - \products\catalog\intensity
PM_catalog3_intensity-4m.bmp 4.0
PM_catalog13_intensity-30m.jpg 30.0
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Lidar Processing

Bare-Earth Models at 1 Meter and 2 Meter (ArcGIS Grids Only), 2.5-Meter and 3-Meter cells

Input: Bare-earth delivered models to be converted to Fusion DTM format
Output: \products\BareEarth
\products\BareEarth\3sections\3sections-grids\
. . be_32109f7: 704 MB (float)
Deliverable Tm 3 sections be_32109f8: 751 MB (float)
be_32110f1: 274 MB (float)
. . \products\BareEarth
Hill shade Tm Project area Be_2mhs: (signed integer)
\products\BareEarth\DOQQ\doqg-grids\
be_g84-1m (float)
be_g83-1m (float)
be_g73-1m (float)
be_g14-1m (float
Arctool> e_g14-Tm {floa)
be_g13-1m (float)
Data management tools>
be_e71-1m (float)
Raster>
Raster processing> be_f84-1m (float)
Cli be_f83-1m (float)
ArcGIS grids P m DOQQ subsets be_f82-1m (float)
be_f81-1m (float
(Created DOQAQ polygon b T ((ﬂ ))
shape files to clip the LA IO
e be_f74-1m (float)
gras be_f73-1m (float)
be_f72-1m (float)
be_f71-1m (float)
be_e82-1m (float)
be_f12-1m (float)
be_f11-1m (float)
. . \products\BareEarth\
Merge grid 2m Project area be_2m (float)
. \products\BareEarth\
Slope 2 m Project area be_ 2ms! (float]
. \products\BareEarth\
Aspect 2m Project area bro Ec s\vareta
e_2masp
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DTM grids
(Fusion)

Grid2ASCIl and Ascii2dtm

\products\

BareEarth\3sections\3sections-dtm\

(createbedtm.bat and Tm 3 sections be_32109f7.dtm: 1.36GB
do2dtm.bat) be_32109f8.dtm 1.44GB
be_32110f1.dtm 528 MB
Mergedtm m \products\BareEarth\
. pm-be-1m.dtm: 4.52 GB
(part of theb(;gaatebedtm. 2é5mm Project area pm-be-2p5m.dtm: 740 MB
pm-be-3m.dtm: 514 MB
\products\BareEarth\D0OQQ\doqq-dtm\
be_g84-1m.dtm
be_g83-1m.dtm
. be_g73-1m.dtm
ngsiﬁgg% & be_g14-1m.dtm
be_g13-1m.dtm
. . be_e71-Tm.dtm
Used in Fusion LTKp -
processor during t_he Eg—;ggmg:m
gridmetrics calculations m DOAQ be_f82-1m.dtm

(needed because the Tm
project area or section
grids were too large
to keep in memory;
intermediary *.asc files
were created as well)

be_f81-1m.dtm
be_e72-1m.dtm
be_f74-1m.dtm
be_f73-1m.dtm
be_f72-1m.dtm
be_f71-1m.dtm
be_e82-1m.dtm
be_f12-1m.dtm
be_f11-1m.dtm

Note: If a 1 m project-area bare-earth model is needed in ArcGIS, the following procedure can be applied:
Multiply the three section grids by 100 ( i.e., convert to cm);

Convert the three sections to an integer grid;

Merge the three grids into a single one;
Divide by 100 (convert back to m).
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Canopy Models and Highest Hit at 2-Meter, 2.5-Meter and 3-Meter Cells

The project-area grids at 2 m resolution were generated from the bare-earth and highest-hit grids. The 2 m CHM was used to
visualize the downed logs in open terrain.

The CHM and CSM models generated by Fusion are at 2.5 m and 3 m. The 2.5 m CHM model was used for further
processing with gridssurfacestats, which creates an output at a multiple of the input CHM.

Input: \point\las\All_points
Tiles las files (CSM and CHM)
\products\BareEarth\3sections\3sections-dtm
BE model in dtm format at 1m resolution (CHM)
Output: \products\canopysurface
\products\Canopyheight
HH_32109f7: 704 MB
Deliverable (highest hit) Tm 3 sections HH_32109f8: 751 MIB
HH_32110f1: 274 MB
Merge grid 2m Project area HH_2m
HH—BE 2m Project area chm_2m
ArcGIS  [Restrict height range of CHM
between 0 and 2m to display 2m Project area cwd_2m
the logs in uncovered terrain
CHM above 25 m
(displays the tallest trees, 2m Project area chm_ge25
most likely old growth)
\products\canopysurface\3m-
LAS tile based dtm\
3m Tile#_CSM-3m.dtm (236)
CSM . \products\canopysurface
(combination of Project area PM-CSM-3m.dtm
createcanopysurfaces.bat \products\Canopyheight\2p5m-
and docanopy.bat) LAS tile based dtm\
25m Tile#_CSM-2p5m.dtm (236)
DTM grids Project area
Fusi
(Fusion) LAS tile based \products\Canopyheight\3m-dtm\
am Tile#_CHM.dtm (236)
CHMI . \products\Canopyheight\
oo o Poiectaes | ™ pu it smetm
ysu : :
bat and docanopy.bat) but _ products\Canopyheight\2p5m-
normalized to the bare-earth LAS tile based . dtm\
model 25m Tile#_CHM.dtm (236)
. \products\Canopyheight\
FEEBE e PM-CHT-2p5m.dtm
25m Project area PM-CHT-2p5m
. PM-CHT-3m
ArcGIS Import ASCIl into arcGIS
3m Project area PM-CST-2p5m
PM-CST-3m
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Volume and Surface Models Derived from 3-Meter CHM at 25-Meter Cells
(Fusion’s “GridSurfaceStats” is not part of the released version of the program as of April 2009. It was developed cooperatively

by Van Kane and Bob McGaughey and will be part of the public version after Kane fulfils the requirements for his PhD at the
University of Washington expected for later 2009.

Input: \products\Canopyheight\
PM-CHT-2p5m.dtm
Output: \products\gridsurfacestats\25m}\
\products\gridsurfacestats\25m
Pm-area25_max_height
DTM grids CreateGridsurfaceStats2b. 25m Pm-area25_pote12l_volume
and * asc bat (a r_nultlple of Project area Pm-area25_s_urface_Are_a (only
filels (creates the *.dtms and | the input 2.5 m created with /area switch)
converts them to *. asc files) CHM) Pm-area25_surface_Area_ratio
Pm-area25_surface_volume
Pm-area25_surface_volume_ratio
\products\gridsurfacestats\25m
pm-maxht-25m
pm-potvol-25m
ArcGIS |Import ASC grids into ArcGIS 25m Project area pm-sa-25m
pm-sar-25m
pm-sv-25m
pm-svr-25m

The first set of grids were created at 30 m and is stored under
\products\gridsurfacestats\30m
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Gridmetrics Models at 25-Meter Cells

Step 1 input:

Step 1 output:

Step 2 output:

\products\BareEarth\DOQQ\dogq-dtm

1m Bare earth dem models at doqq size

\point\las\All_points\
LAS tiles
\products\LTKp_metrics

1 CSV file for each LTKp tile at size defined in batch file

(becomes input for step 2)
\products\LTKp_layers

A project-size DTM grid for each column extracted from the CSV file
An ASCII file and an Arclnfo raster after converting the DTM

DTM grids

Combination of
dometrics_25m.bat and
doLTKpcell.bat on retiled

LTKp grid CSV files

(100 m by 1000 m

\products\LTKp_metrics\

file, merge all the ASCII tiles
into a project-area ASCII
file, convert those to a dtm
and delete the LTKp tile
ASClI files

layers folder as
*.dtm and *.asc)

LAS files in LTKp processor 25m with 100 m buffer) Tile# scy
to extract gridmetrics for (saved in LTKp_ '
points higher than 2 m above metrics folder)
ground surface to a CSV file
products\LTKp_layers\
*.dtm & *.asc
aadht_2plus_25m
aveht_2plus_25m
cover_2plus_25m
cvht_2plus_25m
kurtht_2plus_25m
maxht_2plus_25m
Buildlayers.bat, minht_2plus_25m
extracmetric.bat and modeht_2plus_25m
doextracmetric.bat from p05ht_2plus_25m
DOS window to extract the Proiect area p10ht_2plus_25m
gridmetric from the CSV file, (savejd i LTK p20ht_2plus_25m
create an LTKP tile ASCII 25m P p25ht_2plus_25m

p30ht_2plus_25m
p40ht_2plus_25m
p50ht_2plus_25m
p60ht_2plus_25m
p70ht_2plus_25m
p75ht_2plus_25m
p80ht_2plus_25m
p90ht_2plus_25m
p95ht_2plus_25m
pulsecnt_2plus_25m
skewht_2plus_25m
stdevht_2plus_25m
varianht_2plus_25m
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ArcGIS

ASCII2grid
(Toolbox>conversion
tools>From Raster>Raster
to ASCII).

25m

Project area

products\LTKp_layers\
aadht
aveht
cover
cvht
kurtht
maxht
minht
modeht
p05ht
p10ht
p20ht
p25ht
p30ht
p40ht
p50ht
p60ht
p70ht
p75ht
p80ht
p90ht
p95ht
pulsecnt
skewht
stdevht
varianht

ArcGIS

*Raster calculator:
E = (aveht - minht) / (maxht
- minht)

25m

Project area

\products\Canopyheight E

*Parker and others 2004
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Obstacle Density at 25-Meter Cells

Data prep: \point\las\BE-Ida

convert text files with filtered ground point to LDA format
Input: \point\las\All_points

las tiles

\products\BareEarth\ pm-be-3m.dtm
3m bare earth dtm

\point\las\BE-1da

Filtered ground points in LDA format

Output 1: \products\density_metrics\ under2m
dtm for each defined slice interval (2m in our project) for each LAS tile

Density of the ground points for each LDA tile

Output 2: \products\density_layers\
Project area DTMs, ASCII and ArcGIS grids after merging the DTM from outputl

Fusion
Convert asc to Ida

CreateGptsConvert.bat &
DoGptsConvert.bat

Point file

236 tiles

\point\las\BE-Ida\
tile#_ground_pts.lda

Fusion
DTM and ASCII

\density_layers\

CreateDensityMetrics.bat &
DoDensityMetrics.bat
DoDensitymetric-gpts.bat
Mergedtm and dtm2Ascii

25m

Project area

PM-density-2min-25m

25m

Project area

PM-density-gpts-25m

ArcGIS grid

\density_layers\

Import ASCII into ArcGIS
(Toolbox>conversion tools>From
Raster>Raster to ASCII).

25m

Project area

pm_d2min-25m

Import ASCIl into ArcGIS
(Toolbox>conversion tools>From
Raster>Raster to ASCII).

25m

Project area

pm-dgpts-25m

pm-dfuel-25m =
(pm_d2min-25m —
pm-dgpts-25m)

25m

Project area

pm-dfuel-25m

pm-od-25m =
(pm-dfuel-25m /
pm_d2min-25m)

25m

Project area

pm-o0d-25m

Minimizing the tile edge affects
by setting values less than 0 to
NoData
pm-od-25mnd =
con(pm-0d-25m < 0, pm-o0d-25m,
setnull(pm-od-25m))

25m

Project area

pm-od-25mnd
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Fuel Bed at 1-Meter Cells

Data prep: \point\las\under2m-lda
Subset (clip) the LAS tiles so they contain only returns 2m above the ground or less.

Input: \point\las\under2m-Ida
the <2m agl clipped LDA tiles
bare-earth model at Im in three DOQQ sections

Output: \products\fuel-bed\fuelbed-FSM
Im fuelbed surface model in three sections
\products\fuel-bed\fuelbed-FHM
Im fuelbed height model in three sections

Clip the LAS tiles to the point cloud
LDA height |2m above ground (clip2minfromlas. - . \point\las\under2m-lda\
subsets by tile bat) Point files 236 LDA tiles *tile#min2.lda
(used to look at understory info)
FSM Tm Project area PM-FSM-1m.dtm
CreateFuelbedSurface2minus.bat D0Q1min2_FSM-1m.dtm
and DoFuelbed.bat 1m 3sections | DOQ8min2_FSM-1m.dtm
DTM DOQ7min2_FSM-1m.dtm
FHM Tm Project area PM-FHM-1m.dtm
CreateFuelbedSurface2minus.bat DOQ1min2_FHM-1m.dtm
and DoFuelbed.bat 1m 3sections | DOQ8min2_FHM-1m.dtm
DO0Q7min2_FHM-1m.dtm
\products\fuelbed\
FHM fuelbed-FHM\
ArcGIS (Toolbox>conversion tools>From m 3 sections
Raster>Raster to ASCII). DOQ1Tmin2_FHM-1m.
The FSM was not converted. D0Q8min2_FHM-1m
DOQ7min2_FHM-1m

Field Plot Lidar Data Clipping from LAS Tiles

Data prep: \products\plot-data\samplegrid\samplegrid_utmnad83-v2_Buffe.shp
buffering the plotcenter coordinate (12.62m radius buffer or 0.05 ha plot)
\products\plot-data\samplegrid\plots_tiles_Intersect.shp
\point\las\All_points
Merging LAS tiles and bare-earth DOQQ for 0.05ha plot, overlapping two LAS tiles or DOQQ:s.
LAS tiles: \point\las\All_points\merged4plotclip
(They need to be moved to the \point\las\All_points folder before running the batch file.)
DOQQs: \point\las\All_points\tempdtm4plotclip these with all the DOQQs; there need to be moved to the
\point\las\All_points\merged4plotclip.
\products\plot-data\samplegrid\plot-tile-intersections.xls
The spreadsheet generated from the intersection of the buffered plots with the LAS tiles and the
DOQQ bare-earth boundaries
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Input:

Output:

\point\las\All_points
The LAS tiles, the DOQQs 1m bare-earth models (merged where required)

Lidar point data representing the elevation values (plotid-E.lda) copied to
\products\plot-data\lidarcloud-0p0O5ha\elevation

Lidar point data representing the normalized heights of the data points (plotid-H.1da)
copied to \products\plot-data\lidarcloud-0p0O5ha\height

Cloudmetrics for the height data:
E:\products\plot-data\lidarcloud-0p05ha\height\plotH-metrics.csv
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Appendix 3: Pinaleno Mountains Lidar-Project Data Dictionary

Quality Control and General Information

LAS Tiles Colored According to DOQQ Flight-Line Direction
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Bare Earth Grids

Bare Earth (elevation)

Bare Earth Hill Shade
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Canopy Surface and Height Models

Canopy Height Model at 3 m Canopy Surface Model at 3 m
(elevation in meters) (height in meters)

e = e e an A —— am e mea A -

Fruiets Aounrims  Consy Son5on Mot 1 m LR essntan
Cancpy mHgEr

- H ket ASUnrim « CEaoFy FRgE BdE 18 A iHokEgn

Canopy Height Model = 25 m at 5 m Cell Size

e = = mea an A - = —— s asam A=

i L « Fiine i Ty
hrte] Py Sl e Pl Bl naflsl iided B 18 phanivd i buad

* There is also a canopy surface model and canopy height model at 2.5 m spatial resolution
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Surface and Volume Models Derived from 2.5-meter Canopy-Height Model

Canopy Max. Height at 25 m

Surface Volume at 25 m
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Surface Area at 25 m

Surface Area Ratio at 25 m (2 std. dev. stretch)
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Gridmetrics

AAdht at 25 m

Aveht at25m
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Pulse Count at 25 m
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5th Percentile Height at 25 m 10th Percentile Height at 25 m
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50th percentile Height at 25 m

60th Percentile Height at 25 m
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95th Percentile Height at 25 m ERR: Elevation Relief Ratio
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Obstacle Density and Fuel-Bed Visualization of Forest Floor and Understory
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Appendix 4: Field Maps and Plot Lidar Data Clouds

B Making Mapbooks in ArcMap 9.2

B Lidar data clouds for relating field data

Field Maps and Mapbooks

Brief Description: As a supplemental step to field protocol, field maps were produced for the Pinalefios study area based on
predetermined plot center points. A series of two-sided maps were produced at scales of 1:2,400 and 1:6,000. These maps were
initially created in ArcMap 9.2, using a script named DSMapbooks. You can find the script at this URL: http://edndoc.esri.
com/arcobjects/9.0/Samples/Cartography/Map_Production/DSMapBook/DSMAPBOOK htm. The Mapbooks script enables
the user to produce a map index series based on a polygon shape file (figure 1). The extension permits dynamic labeling for
each plot-location map. This labeling also allows geographic elements like elevation, slope, and canopy-cover percentage to be
indexed to the plot locations.

In addition, lidar data clouds were added
to the mapbooks on the reverse side and
were subset to the 20th hectare plot
locations and to a half hectare for visual
reference. The data clouds were added to
the mapbooks to relate field measurements
to the lidar data clouds. These data clouds
were produced using Fusion software,
which allows the user to subset and
screen-capture them (figure 2). The data 1 )
clouds were then placed in PowerPoint I
slides to be added to an Adobe PDF binder B [
of both the mapbooks and the lidar data i
cloud to compose a two sided map in a o s
single PDF (figure 3). 5 : --r_-“ — -

S Aenw RERDEODR B4 D BE &

[t Y O= A= Er A = mry A N b -

Figure 1—The interface for importing a polygon shape file to produce a set of
indexed maps using DSMapbooks.

Figure 2—O0n the left, the Fusion interface; on the right, a lidar data cloud.
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UTME: &04938.13018T Plﬂt Map DOQ F3
UTMN:  3617197.01913 i
Site ID : 119

Licar Tike: FB405
DOQO: F84

Mty S 2

Figure 3A—An example of the front page of a field map produced with DSMapbooks with a representation of the plots in the
center.
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The reverse side of the field map from figure 3A and the coincident lidar data cloud of the plots.

Figure 3B
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Process:

R . ¥ Tesag |1 inaisseicl e sl

The geospatial layers used in the field maps and their composition are described in this section.

As a starting point for the mapbooks, an original plot center-point shape file was buffered to represent the size of the
field plots, in this case a 20th-hectare circular plot. An additional, larger circular buffer was made to represent
subsequent lidar data-cloud radius plots. These data clouds were imaged on the reverse side of the maps to relate field
findings to lidar data.

The maps it was determined that color-infrared (CIR) imagery should be used as the backdrop for the front of the
field maps. Imagery of the study area was acquired at the time of the lidar data collection and delivered as 1-meter
spatial-resolution and 4 band .tif images, with an available CIR band. This imagery was the primary backdrop in the
mapbooks and required some preprocessing through an ERDAS Imagine model (figure 4). The model separates the
three desired bands—4, 3, and 2—from the original 4-band image, then restacks the bands into a representative CIR
3-band image.

The imagery was then added to the mapbooks and given a 25 percent display transparency. To reveal the 1-meter
spatial-resolution hill shade relief produced for the area from the raw lidar data. This layer added visual topography to
the photos and plot locations that formerly was not possible.

In addition to visual enhancement, dynamic topographic elements were added, in this case as text tables, to the front
page of the mapbooks by producing zonal statistics based on the 20th-hectare plot radius polygon file and lidar-
derived elevation, slope, and canopy-cover percentage layers (figure 5). To add dynamic elements to the set of maps,
ArcTools spatial Analyst processed the zonal statistics on these layers (figure 6).
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Figure 5—An example of dynamic reference on the front of the field maps to elevation, slope, and
canopy cover to a sample plot.
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B Additional GIS vector layers such as roads and trails were added to the mapbooks, and they were exported to PDF

files (figure 7).

B Using Fusion software, lidar data clouds were screen-captured for use in the maps and added to PowerPoint slides. A
toolbar was made, and a macro was written to place them graphically inside the PowerPoint at the correct size (figure
8). Adobe then combined the plot maps and the lidar data clouds into a single PDF binder (figure 9).
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Figure 6—An example of ArcTools Spatial Analyst which produced the zonal statistics. These statistics are operating behind the

scenes to dynamically label items portrayed in figure 5.
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Figure 7—Exporting a mapbook series to .pdf files inside of ArcMap.
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Figure 8— These macros were developed for sizing the pages of lidar data-cloud screen captures.
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Figure 9—The Adobe .pdf binder produced for the two-sided field maps.
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Plot Lidar Data Clouds Subsets

The lidar returns in the 0.05-hectare field plots were subset twice with two separate batch files:
B The first kept the elevations of the lidar points

B The second normalized the elevations to the bare ground (using the 1 m bare-earth DOQQs) by converting the lidar
points to height measurements.

Before the scripts could be generated, the plot centers were buffered in ArcGIS with 12.62 m-radius buffer. The plots, now
representing circles, were intersected with the LAS tile index and the DOQQ boundaries to find out which ones intersected
more than one LAS tile or DOQQ. Where this occurred, the LAS tiles and the DOQQs were merged into a single input file.
Twelve plots (G16, H16, 116, 118, 119, 120, 162, 072, O73, F69, G69 and H69) required merging LAS tiles, and seven
needed DOQQ DTMs combined before the batch script could be generated. The merged LAS files and all the DOQQ files
need to be copied to the \point\las\all_points\ folder for the batch file to work (or the spreadsheet can be edited to point to the
right folders).

The batch files were prepared in an Excel spreadsheet (plot-tile-intersections.xls). The information to build the spreadsheet was
extracted from the table created by intersecting the buffered plots with the tiles and DOQQ boundaries. The resulting dbf
table was further manipulated in Excel.

Figure 10—An example of the point cloud for plot J69, showing elevation values on the left and height values on the right.
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The required minX, min¥, maxX, maxY were calculated from the XY coordinates (X-12.62, Y-12.62, X+12.62, Y+12.62).
Where the plots overlapped 2 tiles or a DOQQ boundary, the necessary substitutions reflecting the file names of the merged
input files were made. Finally, the required syntax switches were added for each line. The final batch file was generated by
concatenating the individual columns into a single one that was copied by a text editor.

The plot data representing point elevations are identified by the £ in the file name: example, J69-E.lda. Those that are
normalized to heights have the leeter A in the filename: J69-H.Ida. The files represented by heights are used to calculate the
cloudmetrics for each plot. The results for plot J69 appear in figure 10.

Unlike the other batch files, which are relatively fast to make and slow to run, creating the one to subset the lidar points
corresponding to the field plot locations takes more time but runs very fast. After double-checking that the required number of
files were created (597) for each of the runs, the content of the LDA files was checked by dropping them into Fusion’s PDQ
viewer. To make sure the subsets coincided with the locations of the plots, the intensity image for the entire project area was
loaded into Fusion, and the shape file with the plot ceters was superimposed on it (figure 11). The resulting file was loaded as a
point of interest (POI), (figure and the LDA files for all the plots). The POI locations and LDA locations should overlap
(figure 12)
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Figure 11—A Fusion display of the intensity map with the field plot locations depicted by a shape file.
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Figure 12— A Fusion display of the intensity map with the field plot locations labeled in preparation for point-cloud extraction
for each plot.
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Appendix 5: Abbreviations

Aadht Average absolute deviation height HH Highest hit
AML Arc macro language HTML Hypertext markup manguage
Asc ASCII file IMU Inertial measurement unit
ASCII American standard code for information kHz Kilohertz
interchange

Kurtht Kurtosis height
Aveht Average height

LAS File extension for lidar files
BAT Batch file extension

LDA Fusion binary lidar format for point data
BE Bare earth

m Meter
CHM Canopy height model

Maxht Maximum height
CIR Color infrared

MGIO Mount Graham International Observatory
cm Centimeter

MGRS Mount Graham red squirrel
CPU Central processing unit

Minht Minimum height
CSM Canopy surface model

Modeht Mode height
CSvV Comma-separated-values file format

NAD North American datum
Cvht Coefficient of variation height

NAIP National Agricultural Imagery Program
CWD Coarse woody debris

NAVD North American vertical datum
CWM Coarse woody material

ND No data
DBH Diameter at breast height

NS North/South
DOQQ Digital ortho quarter quadrangle

OD Obstacle density
DTM Digital terrain model or Plans file extension

P Percentile
FHM Fuel-bed height model

PM Pinalefio Mountains
FSM Fuel-bed surface model

PNWRS Pacific Northwest Research Station
GB Gigabytes

Potvol Potential volume
Ge Greater than

QA Quality assessment
GIS Geographic information system

QC Quality control
GPS Global positioning system

RAM Random access memory
Ha Hectare
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REM DOS batch file comment line that gets N\% Surface volume
ignored during execution

SVR Surface volume ratio (SA/potvol = filled
RFQ Request for proposal volume)
RTK Real time kinematic TB Terabytes
SA Surface area TBD To be determined
SAR Surface area ratio Tile# Tile-ID
SEV Surface filled volume USFS United States Forest Service
Skewht Skewness height USGS United States Geological Survey
SPV Surface potential volume UTM Universal transverse mercator
Stdevht Standard deviation height Varianht Variance height
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